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1ProofReady Plugin for Epson
Variable Size Droplet Printers
Note to OEMs: This document is presented for inclusion in end-user
documentation, such as a manual based upon the
Harlequin RIP OEM Manual, or for use as a supplement
to that manual. You may wish to change the introduc-
tion to this document to suit the presentation you
choose. (Notes like this one are not meant for onward
publication to end-users. They give information of
interest only to staff at Global Graphics and its OEMs.)

1.1 Introduction
This document describes the Epson VSD printer plugin and is suitable for the
following Epson printers:

• Stylus Pro 4000

• Stylus Pro 5500

• Stylus Pro 7600

• Stylus Pro 9600

• Stylus Pro 10000

• Stylus Pro 10600
ProofReady Plugin for Epson Variable Size Droplet Printers 1
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• Stylus Photo 2200

Using Micro Piezo™print head technology these printers deliver extremely
precise ink droplets to produce ultra-sharp resolution prints at high speeds.

Please refer to the Release Notes for the list of platforms on which the plugin
is supported.

1.1.1 Plugin features

The Epson VSD plugin has the following built in features:

• Instant color management using color profiles

• Delivers a wide range of print resolutions and output quality

• Support for PhotoInk (CMYKcm) 6-color output and 7-color
(CMYKcmk) output (some models only)

• Support for HEDS1 and HEDS2, Global Graphics’ advanced screening
technology

• Preview of the screened output

The Epson VSD plugin is provided with pre-configured color setups and cali-
bration profiles that enable instant color management—hence the name
ProofReady.

1.1.2 Biplane device type vs. 2-bit device type

The device type you select determines if the plugin implements two color
planes (a biplane device type) or expects 2-bit screening information from the
RIP (a 2-bit device type). When selecting a device in a Page Setup dialog box,
biplane devices include VSDbi in their name, for example, SP10000 VSDbi

Roll. Whereas 2-bit device types include VSD, for example, SP10000 VSD Roll.

Note also that the HEDS2 plugin must be installed and enabled to output
using the 2-bit device types, see “Installation procedure” on page 4 for details.
In particular HEDS2 must be available when sending output to the
Epson Stylus Pro 4000, 7600, 9600 and 10600, because there are currently no
biplane device types available for these printers.
ProofReady Plugin for Epson Variable Size Droplet Printers



1.1 Introduction
Note: If you try to use a 2-bit device type without installing and enabling the
HEDS2 plugin, the RIP may unexpectedly quit or freeze. We therefore recom-
mend that you use the supplied installer and a password file, to ensure that
the plugin is correctly installed and enabled.

1.1.3 1-bit device types

A separate device type also exists for the Epson Stylus Pro 5500 and the Epson
Stylus Pro 4000 when outputting at a resolution of 360 x 360 dpi. This 1-bit
device type outputs using a fixed dot size, which is more suitable for these
printers at such a resolution. You can also use a 1-bit device type to output to
the Epson Stylus Pro 5500 at 2880 x 720 dpi. This 1-bit device type produces
faster prints, but we recommend that you use the equivalent 2-bit device type
as it produces higher quality output.

For the same reason, a separate device type exists for the Epson Stylus Pro
7600/9600 and the Epson Stylus Pro 4000 when outputting at a resolution of
2880 x 1440 dpi. This 1-bit device type outputs using a fixed dot size, which is
more suitable for these printers at such a resolution.

You can also use 1-bit device types to output to the Epson Stylus Pro
7600/9600 at 360 x 360 dpi. Similarly, these 1-bit device types produce faster
prints, but we recommend that you use the equivalent 2-bit devices types as
they produce higher quality output.

The names for such 1-bit device types refer to the output device and do not
include VSD or VSDbi in their label, for example SP7600 Sheet.

Note that must install and enable the HEDS1 (Harlequin 1-bit Error Diffusion
Screening) plugin or enable the use of HDS/HDS Light to output using the
1-bit device types. “Installation procedure” on page 4 describes how to install
the HEDS1 plugin, in case it is not automatically installed as part of the RIP.
See Section 1.2.3 for details on enabling the use of HEDS1 and HDS screening.

Note to OEMs: See Technical Note Hqn 046 for further details on how
to enable Harlequin 2-bit and 1-bit EDS (HEDS2 and
HEDS1) screening in version 5.5r1c or later of the RIP.
ProofReady Plugin for Epson Variable Size Droplet Printers 3
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1.2 Installation procedure
Before installing the plugin, you should check that you meet the system
requirements listed in Section 1.2.1.

1.2.1 System requirements

Before installing the Epson VSD plugin, ensure your system has the following
requirements:

Harlequin RIP Harlequin RIP 5.5r1c or later installed.

System memory 128 MB RAM.

Minimum disk space 1 GB (more if producing large format or high-reso-
lution output).

Additional plugins Enable ColorPro or HIPP to use the color profiles
supplied with the plugin. See, “ProofReady pro-
files” on page 19. Enable HEDS1 and/or HEDS2 to
use Global Graphics’ advanced screening
technology. Enable HDS or HDS Light to use
Harlequin Dispersed Screening technology.

• For large format or high-resolution jobs, in the Configure RIP dialog
box, increase the Printer buffer setting to at least 20000 KB and Disk
space left for system to 20 MB.

• On Mac OS 9.x, increase the setting for Minimum memory left for system
in Configure RIP to at least 30000 KB.

1.2.2 Using the Product Installer application

This procedure describes how to install the Epson VSD plugin with the
Product Installer application.

1. To start the installation procedure close the Harlequin RIP, if it is loaded.
ProofReady Plugin for Epson Variable Size Droplet Printers



1.2 Installation procedure
2. Double-click the installer file (install-macos9, install-macosx,
install-linux or install.exe), to start the Product Installer applica-
tion (Figure 1.1).

Figure 1.1 The Product Installer application

3. Check the destination folder matches the location of your RIP. If neces-
sary click the Change Folder button to select the correct folder.

4. To install the Epson VSD plugin select the following options:

Package: Optional Plugins, EpsonVSD121_HEDS211

Product: Epson VSD Plugin, 1.2r1

5. Click Add to add the plugin to the list of products to install.
ProofReady Plugin for Epson Variable Size Droplet Printers 5
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6. Many of the ProofReady profiles supplied with the Epson VSD plugin
require HEDS1 and HEDS2 screening to be available in the RIP. If your
RIP does not have these features installed, add them by selecting the fol-
lowing packages and products in the Product Installer:

Package: Optional Plugins, EpsonVSD121_HEDS211

Product: HEDS1, 2.1r1

HEDS2, 2.1r1

7. Click Add to add these items to the list of products to install.

8. When you are ready, click Install to copy the selected products from the
CD to the destination folder. Then click OK to close the Product Installer
application and restart the RIP.

Notice that as the RIP loads the following messages appear in the RIP monitor
window:

If you do not see these messages try reinstalling the plugin and check carefully
that the installation folder matches your RIP installation folder.

Before the printer can be used in a page setup you must enable the Epson
printer(s) in the RIP options, as described in “Enabling the Epson VSD plugin
in the RIP” on page 7.

ProofReady - Epson VSD
Plugin Version 1.2r1 - Copyright (c) 2001-2004 Global

Graphics Software Ltd. All Rights Reserved.

Harlequin Error Diffusion Screening 1-bit Plugin Version 2.1r1
- Copyright (c) 1998-2003 Global Graphics Software Limited. All
Rights Reserved.

Harlequin Error Diffusion Screening 2-bit Plugin Version 2.1r1
- Copyright (c) 1998-2003 Global Graphics Software Limited. All
Rights Reserved.
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1.2 Installation procedure
1.2.3 Enabling the Epson VSD plugin in the RIP

The newly installed Epson VSD plugin and screening options must be enabled
with a password before they become available in the RIP. Often your supplier
will provide you with a password file that contains all the passwords for the
relevant options. To use the password file, place it in
\HarlequinRIP\SW\Passwords\ and restart the RIP. If individual passwords
have been supplied you must enter them in the Configure RIP Extras dialog
box, as described next.

1. Start the Harlequin RIP and open the Configure RIP dialog box
(CTRL+R).

2. In the Configure RIP dialog box, click the Extras button to open the
Configure RIP Extras dialog box.

3. From the list of RIP extras, enable the following options by double-click-
ing the feature you wish to enable and entering the correct password:

Epson, Stylus Pro
<model> VSD

Enables the Epson printer for
use in page setups.

Harlequin ColorPro Enables Harlequin ColorPro
color management, as used by
the ProofReady profiles sup-
plied with the plugin. This
option is only available to the
Eclipse Release RIP.

HIPP Enables HIPP color
management. This option is
only available for pre Eclipse
Release RIPs.

HEDS1 1-bit screening technology
used by the some of the sup-
plied ProofReady profiles.

HEDS2 2-bit screening technology
used by the some of the sup-
plied ProofReady profiles.
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4. Click OK until all open dialog boxes are closed to finish enabling the new
RIP extras.

Figure 1.2 Epson printer and HEDS1 and HEDS2 enabled

1.2.4 Allocating additional memory to the RIP

For correct operation of the plugin you may need to allocate additional
memory to the RIP. If insufficient memory is available, the RIP will not be able
to process a job and may stop working altogether, requiring a restart.

The precise amount of memory required by the RIP to process a particular job
depends on the printer model, page size, output quality and the screening
method employed. For a detailed analysis of how much memory to allocate,
see “Calculating memory requirements for the Epson VSD plugin” on
page 83. Alternatively, enter, using the figures below as a guide, enter settings
for printer buffer, Some initial experimentation may therefore be necessary

HDS or HDS Light Enable HDS or HDS Light to
use VSDbi (biplane) device
types.
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1.2 Installation procedure
before the optimum memory settings for the RIP are found. However, as a
general guide we recommend setting the following options in the Configure
RIP Options dialog box (Figure 1.3).

Figure 1.3 The Configure RIP Options dialog box

Standard size pages or low/medium resolution jobs

• Printer buffer: 20000 KB

• Disk space left for system: 20 MB

• Minimum memory left for system: 30000 KB

Large size pages or high resolution jobs

• Printer buffer: 40000 KB

• Disk space left for system: 20 MB

• Minimum memory left for system: 30000 KB

HEDS1 and HEDS2 screening allocate extra memory as follows

• Printer buffer: 50000 KB

• Disk space left for system: 20 MB

• Minimum memory left for system: 30000 KB
ProofReady Plugin for Epson Variable Size Droplet Printers 9
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If cost is not an issue, we recommend adding extra memory to your RIP box
and increasing the memory allocation options accordingly. In general, the
more memory you can allocate to the RIP, the quicker your jobs will be pro-
cessed and the more stable the RIP will be.

1.2.5 Printer connection

The following figure and table show the supported methods for connecting
Epson VSD printers to various platforms and interfaces. (Some printer inter-
faces are optional upgrades or available on a restricted range of Epson
models.)

Figure 1.4 Printer connection methods

10000/10600
5500 7600/9600 2200 4000

Windows ME A, B, (C), D, E (A), B, (C), D, (E) (A), B, (C), D, (E) B, D, E A, B, E

Windows NT A, (C), D, E (A), (C), D, (E) (A), (C), D, (E) B, D, E A, E

Windows 2000 A, B, (C), D, E (A), B, (C), D, (E) (A), B, (C), D, (E) B, D, E A, B, E

Windows XP A, B, (C), D, E (A), B, (C), D, (E) (A), B, (C), D, (E) B, D, E A, B, E

Mac 9.x A, B, (C) (A), B, (C) (A), B, (C) B A, B

Mac OS X A, B, (C) (A), B, (C) (A), B, (C) B, A, B

Linux A (A) (A) A

ParallelUSBEthernet

ParallelEthernetUSB

JD

Printer:

Computer: Ethernet

(LPR protocol)

Key:

JD JetDirect Unit

A B C D

FireWire

E

Firewire
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1.3 Epson printer device types
Letters in brackets indicate the printer interface is optional or the connection
requires additional software to be installed. For example, an internal 10/100
Base-T type B Ethernet card is optional on the Epson Stylus Pro 7600.

1.2.6 Notes on connections

When connecting the Epson printer to your computer, the following notes
may prove useful:

• When connecting via a parallel printer port on a PC, ensure the parallel
port is set to “Bidirectional” in the system BIOS. Consult your PC
manual for details about accessing and setting the BIOS. If you have any
problems using the parallel port, refer to page 72 and page 78 of the
“Troubleshooting and tips” section.

• When connecting to Mac OS X via USB, ensure the printer has cycled
through its initialization routine before starting the RIP. LCD-equipped
printers should show “Ready”, and non-LCD printers should have their
“Operate” or “Ready” light on steady (not flashing).

• USB to parallel is also supported on Mac OS X, although so far this has
currently only been tested using Epson’s own cable (Epson USB
Adapter ISO USB Smart Cable ISD-103).

• When using a USB connection on the Macintosh it has been found that a
conflict can occur with the 'Internal V90 Modem' Extension. This can
cause communications errors and system lockups during printing.
Disabling this extension can resolve these problems.

1.3 Epson printer device types
Each Epson printer is supplied with a selection of device types. For example,
the Epson 4000 VSD printer has four devices: SP4000 Roll, SP4000 Sheet,
SP4000 VSD Roll and SP4000 VSD Sheet. The device you select establishes
which ProofReady profiles are available to the RIP, which in turn determines
the media type and resolution the output is optimized for.
ProofReady Plugin for Epson Variable Size Droplet Printers 11
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The first time you enable an Epson VSD printer all supported device types for
that printer are made available in the Device Manager and in the Device menu
in the Page Setup dialog box. However, if you enable another Epson VSD
printer you must manually create the device types, as described next.

1.3.1 Creating device types

Roll-fed devices and sheet-fed devices are distinguished by the inclusion of a
suffix; either Roll or Sheet. The VSDbi suffix indicates that the device type
uses two colorant planes to achieve the variable size dot effect (a biplane device
type), and the VSD suffix indicates that the device type expects 2-bit screening
information from the RIP (a 2-bit device type), as described in the “Introduc-
tion” on page 1.

Device types that do not include either a VSD or VSDbi suffix are 1-bit device
types that use a fixed dot size to produce more suitable output for some of the
printers at particular resolutions. For example, a 1-bit device type is used
when printing to the Epson Stylus Pro 7600/9600 devices at a resolution of
2880 x 1440 dpi to help prevent overinking.

If the Device menu in the Page Setup dialog box does not contain the device
that you require, you must use the Device Manager to create such a device:

1. Use the menu option Harlequin RIP > Device Manager to open the Device
Manager. Alternatively, click the Device Manager icon next to the Device
menu in the Page Setup dialog box.

2. Depending on your platform, choose either epsonvsd.i32 or epsonvsd
from the Plugin menu and click New.

Choose the device type you require from the Type menu in the Device
Manager Edit dialog box and enter a name for the device in the Name
text box. If you use the same name as the device type, it must match the
use of uppercase and lowercase letters. Otherwise an error will appear
when using a page setup with this device type, as described on page 76.

3. Click OK. The device will be listed in the Device Manager and become
available for selection in the Page Setup dialog box.

You can now create a page setup using the device, as described on page 13.
ProofReady Plugin for Epson Variable Size Droplet Printers
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1.4 Plugin Limitations
The ProofReady plugin generates an output color format that the printer can
accept. This format is either 6-color or 7-color PhotoInk composite and is
screened using one of several screening options.

The 6-color and 7-color PhotoInk formats impose the following restrictions:

• No use of trapping using EasyTrap and no use of trapping in Eclipse
Release RIPs when using PhotoInk formats. You must use TrapWorks
5.5r0 to trap PhotoInk formats. Note that TrapWorks and TrapPro treat
light inks as separate colors rather than creating a single trap for all inks
of the same color. For example, Cyan and Cyan light are trapped
separately.

• EDS, Error Diffusing Screening is currently not supported on Mac OS X.
However, HEDS1 (1-bit Harlequin Error Diffusing Screening) and
HEDS2 (2-bit Harlequin Error Diffusing Screening) are both supported.

1.5 Creating page setups in the RIP
The procedure for creating a page setup that includes color management dif-
fers according to the RIP version you are using. “Creating a page setup in pre
Eclipse Release RIPs” on page 17 describes the procedure for supported pre
Eclipse Release RIPs. The following instructions are for Eclipse Release RIPs
and later.

1.5.1 Creating a page setup in Eclipse Release RIPs

To create a ProofReady page setup in the Eclipse Release or later of the
Harlequin RIP, you simply need to select a ProofReady profile, as described in
the procedure below.
ProofReady Plugin for Epson Variable Size Droplet Printers 13
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For each numbered step of the procedure the corresponding numbers in
Figure 1.5 highlight where choices are made in the New Page Setup dialog
box.

Figure 1.5 Creating a page setup in Eclipse Release or later RIPs

À Open the Page Setup Manager and click New.

Á Choose the device required from the Device menu.

Note: If the device you require is not in the Device menu, see “Creating
device types” on page 12.

Â Click Configure device to modify configuration settings as desired. See
“Device configuration” on page 28 for details.
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9
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1.5 Creating page setups in the RIP
If using a supplied profile choose the Enhanced Microweave option from
the Quality menu, because the supplied profiles were created using this
setting.

Ã Choose a profile from the ProofReady menu that matches the currently
selected ink/paper type. The correct resolution for the profile is auto-
matically selected and should not be changed.

For example, (Ucm Enhanced Matte 720) is a profile for Epson
Enhanced Matte Paper based on a resolution of 720 x 720 dpi using
UltraChrome™ inks. See “ProofReady profiles” on page 19 for a full list of
supplied profiles.

Note: When you select a ProofReady profile, a default (ProofReady)
color setup is automatically selected in the Color menu. Choose (None)

from the ProofReady menu if you wish to use a ColorPro color setup that
you have created, as described in “Creating a HIPP or ColorPro color
setup” on page 60.

Ä Choose a Separations, Screening and Color option from the Style menu.
There is usually just one option available, which suits the style required
by your output device.

Å If using a biplane device type, check in the Edit Style dialog box that
screening is set to its default value of HDS Super Fine.

Otherwise skip to stepÆ.

To open the Edit Style
dialog box, click the
Separations Manager
icon. Click Edit in the
Separations Manager and
check the screening
option in the Dot shape
menu. Click OK twice to
return to the Page Setup
dialog box.

Æ Choose (None) from the Calibration menu.

Note: Selecting a ProofReady profile includes a default calibration
profile. For optimum results you can choose a calibration set that has
ProofReady Plugin for Epson Variable Size Droplet Printers 15
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been generated for the actual printer rather than for a reference printer.
See “Calibrating the printer” on page 54 for details.

Ç Click Page Layout to specify the positioning of the page, using the
margin and centering controls.

Note: If you are using a sheet-fed device, you must refer to details on
how to control top and bottom margins provided in the Page Layout sec-
tion on page 51.

È Click Save As and enter a page setup name in the Save As text box. Click
Save in the Save Setup dialog box and then OK in the Page Setup
Manager.

You can now use this page setup when printing to produce color managed
output.

Note: When printing on a sheet or roll-fed device the paper source must
match the paper source setting on the front of the printer. Otherwise, if a
printer is loaded with a roll of paper but the paper source is set to sheet the
printer may treat the roll as if it were a single sheet. When printing, the printer
then attempts to feed to the end of the roll.
ProofReady Plugin for Epson Variable Size Droplet Printers



1.5 Creating page setups in the RIP
1.5.2 Creating a page setup in pre Eclipse Release RIPs

This section describes how to create a page setup that includes color manage-
ment in supported pre Eclipse Release RIPs.

For each numbered step of the procedure the corresponding numbers in
Figure 1.6 highlight where choices are made in the New Page Setup dialog
box.

Figure 1.6 Creating a page setup in pre Eclipse Release RIPs

À Open the Page Setup Manager and click New.

Á Choose the device required from the Device menu.

Note: If the device you require is not in the Device menu, see “Creating
device types” on page 12.
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Â Click Configure device to modify configuration settings as desired. See
“Device configuration” on page 28 for details.

If using a supplied calibration profile choose the Enhanced Microweave

option from the Quality menu, because the profiles were created using
this setting.

Ã Choose the desired resolution from the Vertical menu. This sets the
Horizontal resolution to be the same. For example, if you choose
1440 x 1440, this is set to 1440 x 720 when your file is processed. See
page 50 for details.

Ä Choose a Separations, Screening and Color option from the Style menu.
There is usually just one option available, which suits the style required
by your output device.

Å If using a biplane device type, check in the Edit Style dialog box that
screening is set to its default value of HDS Super Fine.

Otherwise skip to step Æ.

To open the Edit Style
dialog box, click the
Separations Manager
icon. Click Edit in the
Separations Manager and
check the screening
option in the Dot shape
menu. Click OK twice to
return to the Page Setup
dialog box.

Æ Choose (None) from the Color menu.

Note: Selecting a calibration profile or calibration set includes a default
color setup. You can choose an option from the Color menu if you wish
to use a color setup that you have previously created. See “Creating a
HIPP or ColorPro color setup” on page 60 for details.
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Ç Choose a profile from the Calibration menu that matches the currently
selected ink/paper type and resolution (as specified in step Ã).

For example, (Ucm Enhanced Matte 720) is a profile for Epson
Enhanced Matte Paper based on a resolution of 720 x 720 dpi using
UltraChrome™ inks. See “ProofReady profiles” on page 19 for a full list of
supplied profiles.

For optimum results you can choose a calibration set that has been gen-
erated for the actual printer rather than for a reference printer. See
“Calibrating the printer” on page 54 for details.

È Click Page Layout to specify the positioning of the page, using the
margin and centering controls.

Note: If you are using a sheet-fed device, you must refer to details on
how to control top and bottom margins provided in the Page Layout sec-
tion on page 51.

É Click Save As and enter a page setup name in the Save As text box. Click
Save in the Save Setup dialog box and then OK in the Page Setup
Manager.

You can use this page setup when printing to produce color managed output.

Note: When printing on a sheet or roll-fed device the paper source must
match the paper source setting on the front of the printer. Otherwise, if a
printer is loaded with a roll of paper but the paper source is set to sheet the
printer may treat the roll as if it were a single sheet. When printing, the printer
then attempts to feed to the end of the roll.

1.6 ProofReady profiles
Instant output color management is provided in the Eclipse Release RIP with
the inclusion of ProofReady profiles. Each ProofReady profile has been devel-
oped by Harlequin RIP color specialists to produce the most natural and vivid
colors possible when used with a particular paper type.
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To use a profile, open the Page Setup window and choose an appropriate
device from the Device list and profile from the ProofReady list, as shown in
Figure 1.7.

Figure 1.7 Availability of ProofReady profiles in Eclipse Release RIPs

Table 1.1 lists the ProofReady profiles supplied with the Epson VSD plugin
and shows the screening method used to create each profile. OEMs wishing to
use screens other than HDS SuperFine, HEDS1 or HEDS2, as appropriate,
must make their own profiles.

Table 1.1 Epson VSD ProofReady profiles

ProofReady Profile
(Device name)

Paper (part no.) Screening

Epson 2200

Premium Glossy 720/1440
(SP2200 VSD)

Premium Gloss (S041286) HEDS2

Premium SemiGloss 720/1440
(SP2200 VSD)

Premium Semi-Gloss
(S041331)

HEDS2

MkLk Enhanced Matte 720/1440
(SP2200 VSD)

Enhanced Matte (S041341) HEDS2

Epson 4000

Enhanced Matte 360
(SP4000)

Epson Enhanced Matte
Paper (SO41725)

HDS Super Fine

Premium Glossy 250g 2880
(SP4000)

Epson Premium Glossy
Photo Paper 250g
(SO41315)

HDS Super Fine

Enhanced Matte 720/1440
(SP4000 VSD)

Epson Enhanced Matte
Paper (SO41725)

HEDS2

ProofReady
profiles

Device list
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1.6 ProofReady profiles
Mitsu PRN Newsprint 720
(SP4000 VSD)

Mitsubishi Newsprint HEDS2

Premium Glossy 250g 720/1440
(SP4000 VSD)

Epson Premium Glossy
Photo Paper 250g
(SO41315)

HEDS2

Premium Luster 250g 720
(SP4000 VSD)

Epson Premium Luster
Photo Paper 250g
(S041737)

HEDS2

SemiMatte Proof 720/1440
(SP4000 VSD)

Epson Proofing Paper Semi-
Matte (SO41724)

HEDS2

SWOP-cert SemiMatte Proof
(SP4000 VSD) See “Notes on the pro-
files” below.

Epson Proofing Paper Semi-
Matte (SO41724)

HEDS2

Epson 5500

Archival Matte 720
(SP5500 VSDbi)

Epson Archival Matte Paper
(SO41339)

HDS Super Fine

Premium SemiGloss 720
(SP5500 VSDbi)

Epson Premium Semigloss
Photo Paper (SO41327)

HDS Super Fine

Pro Glossy 720
(SP5500 VSDbi)

Epson Professional Glossy
Paper (SO41430)

HDS Super Fine

Archival Matte 720/1440
(SP5500 VSD)

Epson Archival Matte Paper
(SO41340)

HEDS2

Premium SemiGloss 720/1440
(SP5500 VSD)

Epson Premium SemiGloss
Photo Paper (S041328)

HEDS2

Pro Glossy 720/1440
(SP5500 VSD)

Epson Professional Glossy
Paper (SO41457)

HEDS2

Epson 7600

Ucm Enhanced Matte 2880
(SP7600)

Epson Enhanced Matte
Paper (S041595)

HEDS1

Ucm Premium Glossy 250g 2880
(SP7600)

Epson Premium Glossy
Photo Paper (250)
(S041638)

HDS Super Fine

Ucm Glossy Photo Wt 2880
(SP7600)

Epson Glossy Paper Photo
Weight (S041388)

HEDS1

Table 1.1 Epson VSD ProofReady profiles (continued)

ProofReady Profile
(Device name)

Paper (part no.) Screening
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Ucm SemiMatte Proof 2880
(SP7600)

Epson SemiMatte Proofing
Paper (S041658)

HEDS1

Dye Glossy Paper Hvy 720
(SP7600 VSD)

Epson Glossy Hvy Wt
(S041291)

HEDS2

Dye Pres Matte 720
(SP7600 VSD)

Epson Presentation Matte
(S041295)

HEDS2

Dye SemiGloss Hvy 720
(SP7600 VSD)

Epson Semi-Gloss Hy Wt
(S041292)

HEDS2

Ucm Enhanced Matte 720/1440
(SP7600 VSD)

Epson Enhanced Matte
Paper (S041595)

HEDS2

Ucm Glossy Photo Wt 720
(SP7600 VSD)

Epson Glossy Paper Photo
Weight (SO41388)

HEDS2

Ucm Premium Glossy 250g
720/1440
(SP7600 VSD)

Epson Premium Glossy
Photo Paper (250)
(S041638)

HEDS2

Ucm SemiMatte Proof 720/1440
(SP7600 VSD)

Epson SemiMatte Proofing
Paper (S041658)

HEDS2

Epson 9600

Ucm Enhanced Matte 2880
(SP9600)

Epson Enhanced Matte
Paper (S041595)

HEDS1

Ucm Glossy Photo Wt 2880
(SP9600)

Epson Glossy Paper Photo
Weight S041388

HEDS1

Ucm Premium Glossy 250g 2880
(SP9600)

Epson Premium Glossy
Photo Paper (250)
(S041638)

HDS Super Fine

Ucm SemiMatte Proof 2880
(SP9600)

Epson SemiMatte Proofing
Paper S041658

HEDS1

Dye Glossy Paper Hvy 720
(SP9600 VSD)

Epson Glossy Hvy Wt
(S041291)

HEDS2

Dye Pres Matte 720
(SP9600 VSD)

Epson Presentation Matte
(S041295)

HEDS2

Dye SemiGloss Hvy 720
(SP9600 VSD)

Epson Semi-Gloss Hy Wt
(S041292)

HEDS2

Table 1.1 Epson VSD ProofReady profiles (continued)

ProofReady Profile
(Device name)

Paper (part no.) Screening
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1.6 ProofReady profiles
Ucm Enhanced Matte 720/1440
(SP9600 VSD)

Epson Enhanced Matte
Paper (S041595)

HEDS2

Ucm Glossy Photo Wt 720
(SP9600 VSD)

Epson Glossy Paper Photo
Weight (S041388)

HEDS2

Ucm Premium Glossy 250g
720/1440
(SP9600 VSD)

Epson Premium Glossy
Photo Paper (250)
(S041638)

HEDS2

Ucm SemiMatte Proof 720/1440
(SP9600 VSD)

Epson SemiMatte Proofing
Paper (S041658)

HEDS2

Epson 10000

Arc Enhanced Matte 720/1440
(SP10000 VSD)

Epson Enhanced Matte
Paper (S041595)

HEDS2

Arc Prem SemiGloss 720/1440
(SP10000 VSD)

Epson Premium SemiGloss
Photo Paper (S041393)

HEDS2

Arc Premium Glossy 720/1440
(SP10000 VSD)

Epson Premium Glossy
Photo Paper (S041390)

HEDS2

Dye Glossy Paper Hvy 720/1440
(SP10000 VSD)

Epson Glossy Paper Heavy
Weight (S041291)

HEDS2

Dye Pres Matte 720/1440
(SP10000 VSD)

Epson Presentation Matte
Paper (SO41295)

HEDS2

Dye SemiGloss Hvy 720/1440
(SP10000 VSD)

Epson SemiGloss Paper
Heavy Weight (S041292)

HEDS2

Dye Glossy Photo 360/720/1440
(SP10000 VSDbi)

Epson Glossy Photo Paper HDS Super Fine

Dye Pres Matte 720
(SP10000 VSDbi)

Epson Presentation Matte HDS Super Fine

Dye Semigloss 720
(SP10000 VSDbi)

Epson Semigloss Photo
Paper

HDS Super Fine

Epson 10600

Arc Enhanced Matte 720/1440
(SP10600 VSD)

Epson Enhanced Matte
Paper (S041595)

HEDS2

Table 1.1 Epson VSD ProofReady profiles (continued)

ProofReady Profile
(Device name)

Paper (part no.) Screening
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See “Halftone screen selection” on page 27 for details on screen sets. If you
need to use the printer in another configuration, you must obtain your own
calibration and color profiles.

1.6.1 Notes on the profiles

The following notes are applicable for the Epson VSD profiles:

• The SWOP-cert SemiMatte Proof profile for the Epson 4000 is based
upon the SWOP (CGATS TR001) data set, and was made by measuring
the IT8 color target over a black background, since this is how the
CGATS TR001 data set was prepared. For this reason, proofs printed
using this profile should be measured or viewed with the print placed
on a black background. (When calibrating the printer for this profile,
however, the calibration target should still be measured over white.)

Arc Prem SemiGloss 720/1440
(SP10600 VSD)

Epson Premium SemiGloss
Photo Paper (S041393)

HEDS2

Arc Premium Glossy 720/1440
(SP10600 VSD)

Epson Premium Glossy
Photo Paper (S041390)

HEDS2

Dye Glossy Paper Hvy 720/1440
(SP10600 VSD)

Epson Glossy Paper Heavy
Weight (S041291)

HEDS2

Dye Pres Matte 720/1440
(SP10600 VSD)

Epson Presentation Matte
Paper (SO41295)

HEDS2

Dye SemiGloss Hvy 720/1440
(SP10600 VSD)

Epson SemiGloss Paper
Heavy Weight (S041292)

HEDS2

Ucm Enhanced Matte 720/1440
(SP10600 VSD)

Epson Enhanced Matte
Paper (S041595)

HEDS2

Ucm Glossy Photo Wt 720/1440
(SP10600 VSD)

Epson Glossy Paper Photo
Weight (S041388)

HEDS2

Ucm SemiMatte Proof 720/1440
(SP10600 VSD)

Epson SemiMatte Proofing
Paper (S041658)

HEDS2

Table 1.1 Epson VSD ProofReady profiles (continued)

ProofReady Profile
(Device name)

Paper (part no.) Screening
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• Some paper types are named differently in different markets. The UK:

and US: prefixes in the Paper Type column show where these differences
are known.

1.7 Profiles and ink types
Epson VSD printers use a variety of ink types, with some models supporting
more than one type. The major types are Photographic Dye, Archival
(ColorFast) and UltraChrome. Some UltraChrome printers also support the
use of different types or combination of Black inks.

If your printer is one that provides a choice of ink type, the type or combina-
tion your printer is using should be selected in the Ink Type menu from one of:

The exact list of options is device dependent, see “Device configuration” on
page 28 for more information.

ProofReady profiles supplied by Global Graphics use a prefix to the profile
name to differentiate, for printers supporting more than one type of ink, the
ink type selection which must be used for the profile.

Dye ink Photographic Dye

Archival (pigment) ink Archival/ColorFast

UltraChrome ink UltraChrome, using the default or only
variation. The default, unless otherwise stated,
is Photo Black for single-black devices, Photo
Black with Light Black for dual-black devices.

UltraChrome
(PhotoK+LightK)

UltraChrome using Photo Black with Light
Black

UltraChrome
(MatteK+LightK)

UltraChrome using Matte Black with Light
Black

UltraChrome (MatteK*2) UltraChrome using 2 Matte Blacks

UltraChrome (PhotoK) UltraChrome using Photo Black on its own

UltraChrome (MatteK) UltraChrome using Matte Black on its own.
ProofReady Plugin for Epson Variable Size Droplet Printers 25



1 ProofReady Plugin for Epson Variable Size Droplet Printers

26
The prefixes for devices supporting more than one major ink type are:

For example:

Arc Enhanced Matte 720

Dye Pres Matte 720

Ucm Prem SemiGloss 720

The prefixes for devices only supporting UltraChrome ink (such as the Stylus
Photo 2200) are:

For example:

Premium Glossy 720

MkLk Enhanced Matte 720

Most professional series printers will reject a job (see "Command error..."
error message, as documented in “Printer-specific messages and symptoms”
on page 62) if the ink type used when the job was processed by the RIP does
not match the inks loaded in the printer. The plugin also tries to query the ink
type where possible, in order to avoid sending a job of the wrong type to the
printer (see “The selected ink type is incorrect...” “Printer-specific
messages and symptoms” on page 62).

Arc Archival (pigment) ink

Dye Dye ink

Ucm UltraChrome (PhotoK) or UltraChrome
(PhotoK+LightK)

UcmMkLK UltraChrome (MatteK+LightK)

UcmMk UltraChrome (MatteK) or UltraChrome
(MatteK*2) for dual-black printers.

MkLk UltraChrome (MatteK+LightK)

Mk UltraChrome (MatteK) or UltraChrome
(MatteK*2) for dual-black printers
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Warning: The Stylus Photo 2200 however does not inform the plugin of the
ink combination in use and does not reject jobs with the wrong ink type.

1.7.1 Halftone screen selection

The Epson 5500 and 10000/10600 print using six inks, for which the RIP sup-
plies density values by conversion from CMYK. As well as the conventional
Cyan, Magenta, Yellow, and Black inks, there are Light Cyan and Light
Magenta inks. Similarly, the Epson Stylus Pro 7600/9600 and the Epson Stylus
Pro 4000 print using 7 inks, which include Light Cyan, Light Magenta and
Light Black. The light inks produce improved highlight rendition.

The RIP supplies a set of screens specially designed for use with six or seven
inks. Each of these halftone screens ensures that the total ink coverage is lim-
ited to a maximum of 400%. These halftone screens are:

HEDS2 This is one of the in-RIP EDS screens used to produce
the supplied profiles for 2-bit device types. It produces
the highest quality output for inkjet printers. To use this
screen, the HEDS2 screening plugin must be installed
and enabled, as described in “Installation procedure”
on page 4.

HEDS1 This is one of the in-RIP EDS screens used to produce
the supplied profiles for 1-bit device types. It produces
the highest quality output for inkjet printers. To use this
screen, the HEDS1 screening plugin must be installed
and enabled, as described in “Installation procedure”
on page 4.

HDS Super Fine
This is one of the screens used to produce the supplied
profiles for biplane device types. If using a supplied
profile based on this screen, ensure that this option is
selected from the Edit Style dialog box accessed from
the Separations Manager. This screen is only available
for use with biplane or 1-bit device types.
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HDS Fine This is an alternative to HDS Super Fine, producing a
coarser screen than HDS Super Fine. This screen is only
available for use with biplane or 1-bit device types.

HDS Medium
HDS Coarse
HDS Super Coarse

The Medium, Coarse, and Super Coarse variants of
HDS are only recommended as special effects screens.
These screens are only available for use with biplane or
1-bit device types.

Chain See “Using Chain screening” on page 79 for details of
recommended settings when using Chain screening.
This screen is only available for use with biplane or 1-
bit device types.

Refer to the Harlequin RIP OEM Manual for further details of screens supplied
with the RIP.

1.8 Device configuration
Device options are accessible from the Configuration Device dialog box,
shown in Figure 1.8. To access this window, click Configure device in a page
setup screen.
ProofReady Plugin for Epson Variable Size Droplet Printers



1.8 Device configuration
Figure 1.8 Epson VSD Configuration dialog box

The options in Configure Device are as follows:

Output method

This option should be set to match your connection interface, or to File

if outputting to disk. The options that appear in the list depend upon the
operating system you are using and the port types it supports.

If you choose Network, specify the IP address and port number in the
Network Output settings. If you choose File, in the File Output settings
specify an output location and a file naming template.

For Windows platforms the standard options are: Network, File, and
LPT1.

Any local Epson printers containing the word Epson (not case-sensitive)
as part of their name, will also appear in this menu, with the SPL: prefix.
Choosing this option will use the Windows printer spooler and the
Epson printer driver to send the plugin data to the printer. This output
method can be used to drive the printer via mechanisms not supported
directly by the plugin.
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Note that on Windows ME/98, the names of network printers may also
appear. This is because Windows ME/98 drive network printers via the
local print provider. We recommend that you disable print spooling,
otherwise the Epson driver will copy the output to file first, which is
unnecessary and can require gigabytes of disk space. The mechanism for
disabling is dependent on the Windows driver. If necessary, refer to your
systems administrator for further assistance.

On Mac OS 9.x the standard options are: Network, File, Port: Printer
and Port: Modem, and on Mac OS X they are: Network and File.

On all platforms you will see an extra entry, prefixed with USB: if you
are driving an output device with a USB port. When using a USB port on
Mac 9.x, the USB option may not appear in this list if you connect to the
device after starting the RIP. If this happens, re-start the RIP. The USB
option should become available. If you have two or more Epson printers
connected to a Mac OS X machine via USB, the plugin differentiates
between them in the Output Method list by adding a numbered prefix to
the printer description, for example USB: #2 Epson Stylus Pro 1000.

File Output: Change

The text box alongside this button shows the location where the plugin
will produce the output file.

Note to OEMs: The file produced is not directly usable on Mac OS 9.x
computers. If you transfer the file to a Windows
platform, you can then use Windows printer services.

The initial folder is the SW folder, which is a subfolder of the RIP applica-
tion folder. Click the Change button to display the Select Folder dialog
box where you can navigate to and select any folder visible to the com-
puter running the RIP. Alternatively, on Windows only, you can edit the
text if you know the exact location of an existing folder.

Note: You can send files to a printer using Windows print spooling by
installing Windows printer drivers on a PC print server, and by entering
the name of the print server in this text box. See “Sending files to a printer
using Windows printer drivers” on page 82 for full details.
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File Output: File template

The text box alongside this button shows the file name template used to
name an output file. (This file is suitable for sending directly to the
printer.)

The default file name template is <dos>out<5unique><dot>epf. This
template produces a file name that is cross platform (8.3 file name) and
suitable for multi-page jobs. It produces file names of the format
out00001.epf, out00002.epf and so on. See “Output file naming” on
page 37 for details on creating a file name template.

Note: You can send files to a printer using Windows print spooling by
installing Windows printer drivers on a PC print server, and by entering
the name of the printer in this text box. See “Sending files to a printer
using Windows printer drivers” on page 82 for full details.

Network Output: IP address

This text box shows the network address of the print server. This address
is a configurable property of a JetDirect unit or similar device. Enter the
network address of the print server that you are using. If your network
supports the use of names, you can enter a name and this will be
resolved to the IP address.

Network Output: Port Number

The text box alongside this button shows the number of the port you
wish to use. If you have installed a 10/100 Base-T type B Ethernet card
the Port Number should be set to 515, unless you are using an Epson
10/100 Base TX Internal Print Server 2 interface card (C12C823914), or
later, in which case you can set it to 9100, for bidirectional
communication.

If sending output to a single printer using a JetDirect unit the Port
Number must be set to 9100.

Some print servers can drive several printers simultaneously and the
different physical connections or ports have their own numbers (which
may vary with the type of server). For example, on a JetDirect unit with
three output ports, the physical ports named 1, 2, and 3 have port
numbers 9100, 9101, and 9102 respectively.
ProofReady Plugin for Epson Variable Size Droplet Printers 31



1 ProofReady Plugin for Epson Variable Size Droplet Printers

32
The RIP supports the use of another printer connected to the same print
server. For example, two computers running the RIP and driving the
same print server can address any compatible printer connected to that
server.

Inks and Media: Media Type

Choose the media type that matches the media installed in your printer.
Media for use with Archival™ inks appears with a (Arc) prefix. Media
for use with Photographic Dye™ inks appears with a (Dye) prefix. Media
for use with UltraChrome™ inks appears with a (Ucm) prefix.

You must choose the correct media type because this determines which
inking regimes and media optimizations are used. For example,
choosing the correct media type ensures the correct adjustment for
media movement. Although, when using the
Epson Stylus Pro 10600/9600/7600/4000, you can “fine tune” the
adjustment for media movement using the Paper Feed Adjustment Offset
option, described below.

Note: The Media Type and Ink Type settings required by supplied profiles
are known to the plugin and these settings override any settings you
may have changed. This is to ensure correct color management.

Note to OEMs: For each of the supplied profiles located in the relevant
device folder within SW\Devices\epsonvsd\Profiles,
an extra file of exactly the same name has been added to
the ProfileHooks folder (also within the epsonvsd

folder), which ensures that the ink and media types are
forced to be those required by the profile. We encourage
you to do the same when you create your own profiles.

This means for example, that if a user selects a
Photographic Dye™ ink profile when outputting to an
UltraChrome device, the job will fail. In this case, either
the plugin detects that the wrong ink is in the printer, or
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the printer generates the "Command error..." error
message, as documented in “Printer-specific messages
and symptoms” on page 62.

In the absence of a hook for a profile, if the ink or media
type are not those required by the profile, the results
will be less color accurate.

Inks and Media: Ink Type

Choose the ink type installed in your device. You must choose the cor-
rect ink type, otherwise an error message will be generated and you will
not be able to print (except on the Stylus Photo 2200, which is unable to
recognize when an incorrect ink type is selected). When using the Epson
Stylus Pro 5500, the Archival (pigment) ink option is automatically
selected and cannot be changed because this printer only supports pig-
ment-based ink sets.

The options for the Epson Stylus Pro 10600 include
UltraChrome (PhotoK) and UltraChrome (MatteK), which correspond
to the two black ink modes available when using an UltraChrome™ ink
set with this device: Photo Black mode (optimized for photographic and
ink jet coated media types) and Matte Black mode (optimized for matte or
plain media).

The options for the Epson Stylus Pro 7600/9600 include
UltraChrome (PhotoK+LightK), UltraChrome (MatteK+LightK), and
UltraChrome (MatteK*2), which correspond to the three black ink
modes available when using an UltraChrome™ ink set with this device:
Photo Black mode (optimized for photographic and ink jet coated media
types); Matte Black mode (optimized for matte or plain media, where
quality is favored over print speed); and Dual Matte Black mode
(optimized for matte or plain media, where print speed is favored over
quality).

The Media Type and Ink Type settings required by supplied profiles are
known to the plugin and these settings override any settings you may
have changed. This is to ensure correct color management.

For example, if you change the Ink Type from UltraChrome to Dye, and
use a supplied profile for an UltraChrome device, the Ink Type will be
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changed back to UltraChrome by the plugin. To check which settings are
used when outputting a job, you can open the Configure Device dialog
box from within the Output Controller.

Paper Feed Adjustment Offset

This option is currently only available when using the
Stylus Pro 10600/9600/7600/4000 (firmware feature).

Enter a value in the range between -70 and +70 to control the rate of feed
of the paper for your particular printer. The default value is 0. Positive
values increase the rate of feed to reduce dark banding. Negative values
decrease the rate of feed to reduce white banding.

Quality

The options that appear in this menu are methods of driving the printer,
which offer combinations of speed and image quality which may
depend on the printer’s capabilities.

If using supplied calibration sets and profiles it is recommended that
you use the Enhanced Microweave option, otherwise choose according to
the following criteria:

Choose Enhanced Microweave when you need optimum quality and are
prepared to wait longer for the printed image.

Choose Faster Microweave if you want fast output and color quality is
not a high priority. For example, you should use this mode when pro-
ducing positioning proofs.

Choose Standard Microweave if you wish to compromise between
speed and quality of output.

Choose Printer Microweave if you wish to send raw data to the printer
and use the printer’s own internal microweaving. This requires poten-
tially less data to be sent to the printer, which may reduce print times,
but may also result in more banding than the Standard Microweave or
Enhanced Microweave options.

Compression mode

The options that appear in this menu are methods of coding the data
sent to the printer.
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None sends the data uncompressed, so the data size is always a predict-
able value though sometimes larger than it need be.

Run Length performs a lossless compression that enables the exact data
to be recreated. For many images, using Run Length will reduce the size
of the data and the time taken to transmit it. For some very complex
pages containing large areas of fine detail, it may take longer to send a
page coded with Run Length than to send the same page coded with
None.

Paper Size

This menu appears in versions of the RIP prior to the Eclipse Release. To
specify your paper size in the Eclipse Release or later of the Harlequin
RIP, you must use the controls in the Page Layout dialog box, as
described on page 51.

The options that appear in this menu are the sizes of paper supported by
the plugin and the printer, as well as the option to create a custom paper
size. There is a small unimageable margin around the edge of all media,
which varies according to the printer model and media size. Refer to
your printer documentation for details.

The standard paper sizes are also available as transverse paper sizes, for
example A4 Transverse. The dimensions of these paper sizes are
reversed, which means that you must choose a transverse paper size if
you have installed the paper in your printer in a landscape orientation.
Landscape is the long edge of the paper leading into the printer and por-
trait is the short edge of the paper leading into the printer.

You can create a custom paper size by selecting the Page Layout media

size option from this menu and specifying the dimensions of the paper
size in the Page Layout dialog box. To open this dialog box, click
Page layout in the Cassette & Page section of the Page Setup dialog box.
Enter dimensions for the paper in the Media Width (MW) and
Media Length (ML) text boxes. If using a roll device, the Media Length (ML)
text box is grayed out. Note that clipping may occur if you change the
paper size in a page setup that used a custom paper size. See page 65 for
full details.
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You can control the positioning of the imaged job on the media by using
the controls in the Page Layout dialog box. See page 51 for details.

Note: You must also select the same paper size using the switches on the
paper tray of the printer. If you fail to make consistent settings, the
output may appear in an unexpected position on the page and be
clipped.

Paper bin

The options in the Paper bin selection menu specify the paper source and
are only available when using the Epson Stylus Pro 5500 and the Epson
Stylus Pro 4000.

• Automatic automatically selects the paper bin which contains the paper
size and type specified in the Device Configuration dialog box. If the
paper bins do not contain the specified paper size then an appropriate
alternative is selected.

Note: You must also ensure that the switches on the front of the printer
for the paper size and type are set correctly, when choosing the
Automatic option.

• Default paper bin selects the default paper bin, regardless of the size
of paper installed in it.

• Paper bin 1/Paper bin 2 specifies which paper bin the printer should
use.

• Manual Feed sets the printer to expect paper to be manually fed.

Cut paper at end of each page

If using a roll-fed device you can select this check box to set the printer
to cut paper at the end of each page. You must also ensure that the Roll

Auto Cut option is selected from the Printer Setting menu on the control
panel of your printer. If you select Roll Cutter Off in the control panel of
your printer, this plugin option is overridden.

Bidirectional printing

Select this check box to use bidirectional printing, which will decrease
the time taken to print each page but may also reduce the quality.
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Post Processing: Enable

Select this check box to enable a post-processing command, as entered in
the Command text field. Leave it unselected to disable post-processing.

Post Processing: Create window

Select this check box (selected by default) to display a command prompt
window: for example, to display any messages produced by the post-
processing command. The command window closes at the end of the
command so, to read any messages, you may need a timed delay before
the command finishes. (A wait for a key-press may be useful for testing
but becomes unworkable with many output files.)

On Mac OS X platforms, the window may not automatically close when
the post-processing command has finished. To change this behavior,
choose Terminal > Window Settings > shell and then select an option.

Post Processing: Command

You can enter commands in this field to perform actions once the page
buffer has been sent to the printer or once the output file has been
created. For example, you may wish to change the format of the output
file or generate a report. For full details, see “Post processing” on
page 45.

Note: The plugin does not support post processing on Mac OS 9.x
computers.

1.8.1 Output file naming

Using text and tags you can automatically generate an output file name from
the job name, job details such as colorant information and resolution, or date
and time information. The tags are entered in the File Template field in the
Epson Configuration dialog box, and a complete list of supported tabs can be
found in Table 1.2, page 38.

Most tags are content tags, representing variables such as the date and time a
job is processed; the other tags allow you to reject names that would be illegal
in a specified operating system. The maximum length of variables can be
specified by preceding the tag name with an integer. For example, <5jobname>
truncates the job name to a maximum of five characters. Tags that produce
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numeric values are truncated from left to right, whereas tags that produce
alphanumeric strings (strings containing the characters a-z, A-Z, and 0-9) are
truncated from right to left. See “Examples of tag usage” on page 40 for fur-
ther details.

Fixed text can be part of the file name stem or extension. For example,
stem_<3unique><sepname><dot>epf would generate a file name of the form:
stem_000Cyan.epf, in which stem_ can be any identifying text.

Try to use a file name extension that does not clash with any established
convention. The extension epf is a suggestion only and is formed from the ini-
tial letters of Epson Printer File.

Note: This file naming scheme does not provide useful file names derived
from job names that contain double-byte characters.

1.8.2 Content generating tags

The following tags are available and can be used in any order:

Tag Description

<ascii> This limits the character set of the file name (from the point of the tag
onwards) to ascii characters in the range 32 (0x20) to 126 (0x7E). Char-
actors outside this range are discarded. If the user wishes to substitute
invalid characters rather than discarding them, prefix the ascii tag with
the substitution character value in decimal.

<colorant> The color space of the device, such as PhotoInkBiplane

<colorname> The name of the separation, such as Cyan.

<date> The date when the job is processed, in the format YYYYMMDD, unless a
truncated form is specified.

<dot> Separates the stem of the file name from the file extension, and appears
as a period character ( . ) in the file name. For example,
stem<dot>ext appears as stem.ext. The use of the <dot> tag
enables the verification of the stem and extension lengths.

<job#> The job number allocated by the RIP. Automatic numbering means that
successive jobs have incremented job numbers: 000, 001, 002, 003, and
so on.

Table 1.2 Output file name tags
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1.8.3 Checking tags

The plugin always checks the legality of an automatically generated file name
against the requirements of the operating system on which the RIP and the
plugin are running.

To enable portability of files from one operating system to another, you can
also use tags to specify the operating system for which generated file names
must be suitable. The use of these tags changes the rules by which a file name
is deemed valid. The tags do not modify the file names generated, but cause
error messages if the file name is invalid. See “Messages for file name tem-
plates” on page 73 for details.

<jobname> The page buffer name without the page number prefix and without char-
acters illegal to the operating system. White space characters are used, if
present in the job name.

<jobname1> The page buffer name without the page number prefix, and using only
alphanumeric characters (a-z, A-Z, 0-9). White space characters are not
used.

<jobonly> This gives the job name without the separation name in brackets, For
example, where <jobname> would give myjob(PANTONE Reflex
Blue CVC), <jobonly> will give myjob.

<page#> The page number (allocated by the RIP), within the current job. For
example: 002.

<prefix> The page number prefix from the page buffer name, such as 1., 2., and
so on.

<prefixonly> You can use this tag to include the characters from the prefix before the
full stop in the job name (that is, the prefix, not including the dot and
space characters).

<time> The time when the job is processed, in the 24-hour format HHMMSS,
unless a truncated form is specified.

<unique> A unique sequence number used to make file names unique when out-
putting files to a directory.

<xres> The horizontal resolution of the page, as specified in the page setup.

<yres> The vertical resolution of the page, as specified in the page setup.

Tag Description

Table 1.2 Output file name tags
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For example, you can create the template <dos>Averylongfilename.epf, but
an error is generated. This error occurs because DOS file names require the 8.3
format for stem and extension, which this template fails to meet by having 17
characters in its stem. Table 1.3 lists the operating system tags.

1.8.4 Examples of tag usage

The following examples demonstrate the format of strings produced by indi-
vidual tags. Some examples also show how the tags may be used in combina-
tion to form a template. The examples are based on these job details:

Page buffer name: 1. Uncalibrated Target: Epson Stylus Roll-Fed 4-Color Target

Date: 12th of April, 2001

Note: When creating multiple copies of a file, the same page buffer provides
tag information. If a template contains dynamic tags (such as <time>, where
the value changes each time that a page buffer file is output), then multiple
copies of the file are created. If the template contains just static tags (such as
<jobname>, where the job name remains constant), then a single output file is
created because previous files are overwritten.

<colorant>

This tag includes the color space of the device in the file name string.

Tag Description

<dos> Verifies that the file name is a legal file name for the MS-DOS operating
system.

<mac> Verifies that the file name is a legal file name for the Mac OS 9.x operating
system.

<macosx> Verifies that the file name is a legal file name for the Mac OS X operating
system.

<unix> Verifies that the file name is a legal file name for the UNIX operating system.

<win32> Verifies that the file name is a legal file name for Windows operating systems:
Windows 95, Windows 98, Windows NT, or Windows 2000.

Table 1.3 Operating system tags
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For example, the template <colorant><dot>epf produces a file name of
the form PhotoInk.epf for a device using a PhotoInk color space.

<colorname>

The tag <colorname> can be used to include the name of the separation
in a file name, for example: Cyan. You can include just the first letter of
the separation by using the tag <1colorname>, which truncates the sepa-
ration name to its first letter. If a composite style is used this is indicated
by the string Composite. If a monochrome style is used this is indicated
by the string Gray.

<date>

The template <date><dot>epf produces the file name 20010412.epf.
You can remove the year information by using the tag <4date> to pro-
duce the file name 0412.epf.

<dos>

The use of this tag verifies that the file name is suitable for use in a DOS
operating system. Illegal characters such as a colon, and white space
characters are removed.

For example, the template <dos><jobname><dot>epf, would generate an
illegal file name because the job name is greater than the eight characters
allowed in DOS operating systems. Truncation can be forced by using
the template <dos><8jobname><dot>epf, which produces the file name
Uncalibr.epf.

<dot>

This tag separates the file name stem from the file name extension and
enables the verification of their lengths. It is particularly necessary when
creating file names compatible with DOS and Windows, otherwise the
extension may be considered as part of the file name.

For example, the template <dos><8jobname>.epf would cause an error
because the dot is removed as an illegal character and epf is then consid-
ered part of the file name stem.
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<job#>

You can use this tag to include the job number in the file name string.
The default length of the number is three digits, so the first file name cre-
ated with this tag would be 000, unless a different length is specified.
You can specify the length of the job number by preceding the <job#>

tag with an integer. For example, <5job#> creates job numbers five
digits long.

In multi-page jobs use the <page#> tag as well as the <job#> tag to differ-
entiate between the different pages of a job.

<jobname>

This tag ensures that only legal operating system characters are used in
the job name.

For example, in the RIP running under any Microsoft Windows operat-
ing system, the template <jobname><dot>epf can produce the file name
Uncalibrated Target Epson Stylus Roll-Fed 4-Color Target.epf.
The colon character ( : ) is removed from the file name, because this is
not a valid file name character for any version of Microsoft Windows.

<jobname1>

This tag ensures that only alphanumeric characters are used in the job
name.

For example, in the RIP running under a Windows operating system, the
template <jobname1><dot>epf can produce the file name
UncalibratedTargetEpsonStylusRollFed4ColorTarget.epf. The
colon, hyphens and white space characters are removed from the file
name, because they are not alphanumeric characters.

<mac>

The use of this tag verifies that the file name is suitable for use in a
Mac OS 9.x operating system. Illegal characters such as an asterisk,
colon, and quotation marks are removed. The maximum length of a file
name is thirty-one characters (including the file extension).
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For example, using the template <mac><28jobname><dot>epf produces
the file name Uncalibrated Target Epson S.epf, in which the colon
has been removed.

<macosx>

The use of this tag verifies that the file name is suitable for use in a
Mac OS X operating system. Illegal characters such as a colon, or
double-quotation marks are removed.

For example, the template <macosx><jobname><dot>epf produces the
file name Uncalibrated Target Epson Stylus Sheet-Fed 4-Color

Target.epf, in which the colon has been removed.

<page#>

You can use this tag to include the page number in the file name string.

For example, the template <page#><dot>epf produces a file name of the
form 001.epf. It is advisable to use this tag with the job number tag to
differentiate between the same pages of different jobs.

<prefix>

You can use this tag to include the page number prefix from the page
buffer name in the file name string.

For example, based on the page buffer name above, this tag produces the
string 1.

<time>

You can use this tag to include the time a file is processed in the file
name string.

For example, if printing to file at 15:39:36 (approximately 3:39 pm) this
tag produces the string 153936.

<unique>

You can use this tag to generate a unique sequence number for the page.
The default length of the number generated is four digits long, so the
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first number would be 0000. The length of the number can be specified,
as detailed in the example for the tag <job#>.

When restarting the RIP, the unique numbering will attempt to restart at
its initial value, for example: 0000. However, if a file exists with that
number, the next available unique number is used.

<unix>

The use of this tag verifies that the file name is suitable for use in the
UNIX operating system. Illegal characters such as an asterisk, colon, and
quotation marks are removed. The <dot> tag cannot be used with this
tag because file names in UNIX are composed of a single string and are
not considered to have separate file extensions.

For example, using the template <unix><255jobname>.epf produces the
file name UncalibratedTargetEpsonStylusRoll-Fed4-

ColorTarget.epf, in which the colon and white space characters have
been removed.

<win32>

The use of this tag verifies that the file name is suitable for use in a
Windows operating system. Illegal characters such as an asterisk, colon,
or quotation marks are removed.

For example, the template <win32><jobname><dot>epf produces the file
name Uncalibrated Target Epson Stylus Sheet-Fed 4-Color

Target.epf, in which the colon has been removed.

<xres>

You can use this tag to include the horizontal resolution of the page in
the file name string.

For example, you can differentiate between pages with a resolution of
1440 x 720 dpi and 720 x 720 dpi by using this tag. This tag produces a
string such as 1440 or 720, depending on the horizontal resolution.

<yres>

You can use this tag to include the vertical resolution of the page in the
file name string. For example, on a page with the resolution 1440 x 720,
this tag produces the string 0720.
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1.8.5 Post processing

The Configuration dialog box has a Post Processing: Command text box in
which you can enter commands and their options, in the same way as a com-
mand line. These commands are carried out after the page buffer has been
sent to the printer or once the output file has been created. The commands
available depend on the platform on which you are running the RIP.

Note: You cannot perform post processing if you are using a Mac OS 9.x
computer.

The command can be a simple batch file or a complex application, provided
that you give the command all necessary options and information; a com-
mand needing operator intervention is likely to cause problems. You can spec-
ify options understood by the application, and data such as the path of the
relevant input or output files.

You can use post processing commands to convert the file to a different format
or to send somebody an e-mail notifying them that a job has been processed.
There are several other possibilities, such as extracting information for use in
reports, limited only by your ability to obtain or create a suitable application
and to supply information to it.

If the string you enter into the Post Processing: Command text box refers to a
post processing application then this application must be available on the
computer running the RIP. The string should normally include the file exten-
sion and the full path name of the application file. However, you can type just
the file name if the application file has the extension .EXE and is in one of the
directories specified by the PATH variable.

Your string can contain substitution codes, which are expanded by the RIP.
See “Post processing substitution codes” for details.
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1.8.5.1 Post processing substitution codes

When using the post processing feature of the Epson VSD plugin, the RIP rec-
ognizes the substitution codes in the following list. You can insert an integer
between the percent character and the letter code, to restrict the maximum
number of characters used in the result string. For example, %6j represents the
first six characters of the job name.

Post processing
substitution codes

Description

%c The current separation color, represented by a string with a default
length of one character. Typical separation names are Cyan,
Magenta, Yellow and Black. Examples for the default length are:
C, Y, M, and B.

%d The current date in the format YYYYMMDD, with a default string
length of 8. For example, 26 October 2000 becomes: 20001026.

%f The output file name, as created by the template specified in the File
Output: File Template text box in the Configuration dialog box. For
example: out00001.epf.

%g The current page buffer name as shown in the Output
Controller/Monitor, after removal of the numeric prefix and non-
alphanumeric characters. For example: the page buffer name 1.
Apple.ps becomes Appleps.

%j The current page buffer name as shown in the Output
Controller/Monitor. For example: 1. Apple.ps.

%n The current job number, an integer that the RIP increments each
time it processes a new job. For example: 15.

%o The full output directory path specified in the File Output:
Change... text box. For example: C:\SWNT\SW\Output\.

%p The current page number within the job. For example: 4.

%r The job resolution in dots per inch. For example: 300.

%s The current page buffer name as shown in the Output
Controller/Monitor, after removal of the numeric prefix, any bracketed
text and any text that appears before a colon (:), semi-colon (;), a
commercial at symbol (@), and a hyphen (-). For example: the page
buffer name 1. Apple-test(new).ps becomes test.ps.

Table 1.4 Post processing substitution codes
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1.8.5.2 Checking the command string

The RIP reports each command and the working directory in the main RIP
monitor window, in the following form. Italics show which text can vary with
different jobs and page setups.

Running post-job command "C:\test\logfile.bat out00002.epf
112442" in directory C:\SWNT\SW\Output

The above example refers to a batch file (logfile.bat) which uses a program
to send an e-mail confirming that a job has been processed. The e-mail con-
tains the output file name (out00002.epf) and the time it was processed
(approximately 11:24). These details were provided by using the substitution
codes %f and %t in the post processing text box. The working directory is the
output file folder specified in the File Output: Change... text box. If no output
file folder is specified then the working directory is the ‘..\SW\’ directory,
which is one level below the directory containing the RIP executable.

For a more thorough test of how commands behave when used at the com-
mand prompt of the operating system, try creating a batch (.BAT) file with
these contents and using the name of the batch file as the application in your
command string.

echo %1 %2 %3 %4 %5 %6 %7 %9
pause

Note: If you have problems with a command, test it outside the RIP by open-
ing a command window and running the command manually. If you think
that you have used any substitution code from which the RIP might generate

%t The current time in the format HHMMSS, using the 24 hour clock.
The default length is 6. For example, a time just after 7:30 pm would
be shown: 193211.

%x The current file name suffix. For example: epf.

%z The current file name stem. For example: out00001.

Post processing
substitution codes

Description

Table 1.4 Post processing substitution codes
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an element containing characters with a special meaning to your operating
system, try surrounding that code with double quotes. For example, use "%f"

in the post processing text box rather than just %f.

If there are no special characters involved, look at the number of substitution
codes that you are using and the length of the command string both before
and after expansion of the substitution codes. The limit on the length of the
expanded command string varies with the Microsoft Windows environment
but you should have no problems with up to 125 characters in the string after
expansion.

1.9 Routine plugin use
Details on general usage of the plugin are provided under the following
headings:

• “Page Setup settings” on page 48- explains the choices in the page setup
dialog box.

• “Roaming page buffers” on page 53 - offers details on previewing
output to PhotoInk devices.

1.9.1 Page Setup settings

To send output to a device or file you must create a page setup. This involves
two main steps. Firstly, you must choose your device from the Device menu in
the Page Setup dialog box and configure the device as described in “Device
configuration” on page 28. Secondly, you must set the desired page setup
options to complete a page setup.

The page setup controls that you generally need to consider are described
below. See the Harlequin RIP OEM Manual for further details.

Device

The Device menu offers a list of supported device types.

If the device type that you require is not available in this menu, see
“Creating device types” on page 12.
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ProofReady

This menu appears in Eclipse Release or later RIPs. You can choose a
ProofReady profile from this menu which uses a color setup and calibra-
tion profile for a particular paper, ink and resolution combination. See
“ProofReady profiles” on page 19 for further details.

When you select a profile from this menu, the correct resolution is auto-
matically set and should not be changed. A default (ProofReady) color
setup is also used. If you wish to use a color setup that you have created,
choose (None) from this menu. See “Creating a HIPP or ColorPro color
setup” on page 60 for details on how to create your own color setup.

Style

By default, there is only one option in the Style menu in the Separations,
Screening & Color section of the Page Setup dialog box: PhotoInkBiplane
Composite.

Make the choice offered; it suits the format required by the printer.

You can create other styles using the Separations Manager. Refer to the
Harlequin RIP OEM Manual for details. See “Using Chain screening” on
page 79 if you have problems with Chain screening.

Color

In versions of the Harlequin RIP prior to the Eclipse Release, the selec-
tion of a supplied calibration profile, or a calibration set created on the
basis of a supplied profile, includes a default color setup. Set Color to
(None) if you wish to use the default color setup. You can use the sup-
plied color profiles to create your own color setup, as described in “Cre-
ating a HIPP or ColorPro color setup” on page 60. “Creating and
installing ICC profiles” on page 58 describes the production and installa-
tion of your own profiles, which you can then use to create a color setup.

In the Eclipse Release or later RIPs, the selection of a profile from the
ProofReady menu includes a default (ProofReady) color setup. You can
use the supplied color profiles to create your own color setup, as
described in “Creating a HIPP or ColorPro color setup” on page 60. To
use your own color setup, you must choose (None) from the ProofReady
menu.
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You can also create a New ‘ProofReady’ Setup if you wish to use a
ProofReady profile but modify some of the default settings, such as those
for overprinting. To create a New ‘ProofReady’ Setup you must access the
Color Setup Manager with a ProofReady profile selected. The options are
the same as those for a New ‘No Color Management’ Setup, as described in
the Harlequin RIP OEM Manual.

Note to OEMs: The default color setup for ProofReady profiles uses
SWOP (CGATS TR001) as the CMYK input profile and
Trinitron as the RGB input profile. This can be
changed using PostScript. Contact support for more
details.

Resolution

Choose resolutions that satisfy your desire for speed of output (lower
resolution) or quality (higher resolution).

In the Eclipse Release the supported resolutions can be selected from a
single list, whereas in pre Eclipse Release RIPs the resolutions are
selected from Vertical and Horizontal lists that have been designed to pre-
vent you from selecting an invalid combination. For example, you can
choose 360 x 360, but not 360 x 720. A message confirming this change is
displayed in the RIP monitor.

Similarly, if you wish to output at 2880 x 720 dpi (Epson Stylus Pro 5500)
or 2880 x 1440 dpi (Epson Stylus Pro 7600/9600/4000), you must choose
2880 x 2880 and the resolution is changed during processing.

Note: If you use profile based on a specific resolution, ensure the resolu-
tion matches.

Calibration

You can select a calibration profile or calibration set from the Calibration
list in the Calibration & Dot Gain section.

In versions of the RIP prior to the Eclipse Release, the selection of a cali-
bration profile or calibration set includes a default color setup, unless
you choose an alternative from the Color menu. Note that if you choose
an alternative color setup, ensure that it is suitable for the paper type,
ink and resolution.
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In the Eclipse Release and later RIPs, the selection of a profile from the
ProofReady menu includes a default calibration profile. Set Calibration to
(None) if you wish to use the default calibration profile. For optimum
results you can choose a calibration set that has been generated for the
actual printer rather than for a reference printer. See “Calibrating the
printer” on page 54 for details.

Page Layout

The margins and centering options control where the imaged job
appears on the media. There is a small unimageable margin around the
edge of the media, which varies according to the printer model. Refer to
your printer documentation for details. The positioning of the job is also
different for roll and sheet-fed devices.

Roll-fed When the device is roll-fed, the page defined by the job
is located at the top-left of the sheet, unless you set a
non-zero Left Margin or select the Center page on Media
Width check box. You can also set both the Top Margin
(TM) and the Bottom Margin (BM). If you increase the
Bottom Margin (BM) on a roll-fed device this adds space
to the bottom of the page.

Sheet-fed When the device is sheet-fed, the origin of the page
defined by the job is located at the bottom-left of the
sheet. However, in the Page Layout dialog box of some
versions of the RIP, only the Top Margin (TM) is editable
with a default value of 0.00 inches. If these default set-
tings were applied the job would be located at the top-
left of the sheet. To prevent this, the Top Margin (TM) is
applied as the Bottom Margin (BM). If your version of the
RIP needs to swap these values a message confirming
this is displayed in the RIP monitor window.

If you increase the Bottom Margin (BM) on a sheet-fed
device, space cannot be added to the bottom of the
page. This means that the space available on the sheet is
reduced.
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The Page size represents the frame within which text and images are
printed. Whereas Paper Size (specified in the Epson Configuration dialog
box) is the size of the medium printed on. In order to print unclipped
pages the page size must not exceed the paper size. Because the Paper
Size is specified in the Epson Configuration dialog box, you do not need
to specify the Media Width or Media Length, unless creating a custom
paper size.

Note: The Page size that you can choose here is only important if you
print a job that does not specify its own page size. Such jobs are rare, but
include EPS files and the job created by the menu option Fonts > Proof
Fonts.

The use of the media controls depends on the RIP version that you are
using:

Pre Eclipse Release RIPs:
The Page size represents the frame within which text
and images are printed. Whereas Paper Size (specified
in the Epson Configuration dialog box) is the size of the
medium printed on. In order to print unclipped pages
the page size must not exceed the paper size. Because
the Paper Size is specified in the Epson Configuration
dialog box, you do not need to specify the Media Width
or Media Length, unless creating a custom paper size.

Note: The Page size that you can choose here is only
important if you print a job that does not specify its
own page size. Such jobs are rare, but include EPS files
and the job created by the menu option Fonts > Proof
Fonts.
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Eclipse Release or later RIPs:
The Page size represents the frame within which text
and images are printed. Whereas Media Size is the size
of the medium printed on. In order to print unclipped
pages the page size must not exceed the media size.

From the Media Size menu choose either a standard
media size or Other to use the Media Width (MW) and
Media Length (ML) text boxes to specify a custom media
size. If using a roll device, the Media Length (ML) text box
is grayed out.

When you select a standard paper size, its dimensions
are shown in the Media Width (MW) and
Media Length (ML) text boxes. All the standard paper
sizes are also available as transverse paper sizes, for
example A4 Transverse. The dimensions of these paper
sizes are reversed, which means that you must choose a
transverse paper size if you have installed the paper in
your printer in a landscape orientation. Landscape is
the long edge of the paper leading into the printer and
portrait is the short edge of the paper leading into the
printer.

Make all other settings as normal, following the suggestions in the Harlequin
RIP OEM Manual.

1.9.2 Roaming page buffers

You can view page buffers on screen using the standard RIP tools, but some
things are potentially confusing when you are viewing PhotoInk page buffers:

• The title bar of the Roam window displays asterisk ( * ) characters,
where you might expect to see letters representing the colors in the page
buffers. This is normal when the color system is not Gray, RGB, or
CMYK.
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• Objects that are drawn in shades of colors, for which there are two or
more inks in use, disappear only when you turn off the display of both
inks. For example, when the cyan component uses both Photo Cyan and
Photo Cyan Light, some of the cyan component remains visible until
you use the Roam Options dialog box to turn off both inks.

• When using Roam to preview output, the image displayed has poor
color fidelity. In particular, the image may appear less saturated. This is
because the Roam preview does not account for the dot gain that occurs
when printing.

• When viewing a page that uses a resolution of 1440 x 720 dpi the aspect
ratio is maintained, which may cause the file to appear elongated.

1.10 Color management
This section describes the processes involved in color management, including:

• “Calibrating the printer” on page 54

• “Creating and installing ICC profiles” on page 58.

• “Creating a HIPP or ColorPro color setup” on page 60

• “Using Harlequin Full Color System (HFCS)” on page 61

For more information on managing color in the Harlequin RIP, see Harlequin
Color Production Solutions User’s Guide (for details on HIPP and HFCS) and
Harlequin ColorPro™ User’s Guide (for details on ColorPro).

1.10.1 Calibrating the printer

We recommend calibrating the printer for each device type and paper/resolu-
tion that you use. To provide a useful starting point the plugin is supplied
with a number of calibration profiles which define the ideal or ‘reference’ state
for the printer. The profiles are installed in
…RIP_folder\SW\Config\Devices\DevCalibration\, one for each device
type.

The response of your printer (the ‘user printer’) may differ from the reference
printer. To obtain optimum output quality you need to calibrate the printer so
that it responds in the same way as the reference printer. The adjustments
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needed to correct the user printer so that it matches the reference printer are
defined in a calibration set. The supplied calibration profiles are distinguished
from user-generated calibration sets by being enclosed in parentheses, like
these( ).

The way in which you calibrate your device depends on the Harlequin RIP
version that you are using. For details on calibration in the Eclipse Release and
later RIPs, see “Eclipse Release calibration procedure” on page 55. For details
on calibration in pre Eclipse Release RIPs, see “Calibration procedure for pre
Eclipse Release RIPs” on page 57.

1.10.1.1 Eclipse Release calibration procedure

To ensure accurate calibration, it is recommended that three targets are
printed and measured. For subsequent recalibrations, an accurate profile can
be achieved with one pass, as described in “Recalibrating the printer” on
page 58. Before you begin calibrating, load the correct paper and initialize the
printer according to the manufacturer’s instructions.

Print and measure an initial target

1. Create a page setup in the Harlequin RIP with the following options:

• Device—select the correct device

• ProofReady—select (None)

• Calibration—select the paper/resolution type

2. In the Harlequin RIP, click Output > Print Calibration to open the Print
Calibration window. From the list choose your page setup then click
Print uncalibrated target.

3. Measure the printed target with Genlin, or your preferred calibration
program. Genlin is installed with the Harlequin RIP and is described in
the Harlequin RIP OEM Manual.

4. In the Harlequin RIP, click Output > Calibration Manager to open the
Calibration (Dot Gain) Manager. In the Manager click Device and select
the correct device, and then click New to open the Edit uncalibrated
target for… window.
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5. In Edit uncalibrated target for…, click Profile and select the correct
paper/resolution type. All other options should be left at their default
settings (ensure Force solid colors remains unchecked).

6. In the Name field, enter an appropriate name for the initial profile, for
example Ucm Enhanced Matte 720-1 and click Import > Import to read
the calibration data.

7. Click OK until all open windows are closed.

Print and measure a second target

1. Open your page setup (the one you used to print the initial target). From
the Calibration list, select the calibration profile you just created (Ucm
Enhanced Matte 720-1) then click OK to close the page setup window.

2. Open the Print Calibration window. Select your page setup and click
Print calibrated target (note this time you are selecting calibrated target).
Measure the printed target.

3. Open the Calibration (Dot Gain) Manager. Select the appropriate device
and choose the calibration profile that you made with the initial target.

4. Click the Copy button to create a duplicate of the profile. From the list
select the copy and click Edit from calibrated target to open the Edit cali-
brated target for… window.

5. Change the name of the profile to Ucm Enhanced Matte 720-2 and click
Import > Import to add the calibration set.

6. Click OK until all open windows are closed.

Print and measure a final target

1. In the RIP, open your page setup and from the Calibration list select Ucm
Enhanced Matte 720-2. Click OK to close the window.

2. Open the Print Calibration window. Select your page setup and click
Print calibrated target. Measure the target with Genlin or your favorite cal-
ibration program.

3. Open the Calibration (Dot Gain) Manager. Select the device and the cali-
bration set you created for the second target.
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4. Click the Copy button to create a copy of the profile. Select the copy and
click the Edit from calibrated target button.

5. Name the profile Ucm Enhanced Matte 720-F, to indicate it is the final
calibration set. Click Import to read the calibration data, and click OK to
add the calibration set to the Calibration Manager. You should remove
all the intermediate calibration sets from the Calibration Manager to
avoid choosing the wrong profile in a page setup.

6. Modify your page setup so that it uses the final calibration set.

1.10.1.2 Calibration procedure for pre Eclipse Release RIPs

The calibration procedure described here is for users of supported pre Eclipse
Release RIPs. Perform the calibration procedure for each device type and
paper/resolution that you use. Recalibrate the printer at regular intervals to
maintain accuracy, as described in “Recalibrating the printer” on page 58.
Before beginning a calibration, load the correct paper and initialize the printer
according to manufacturer’s instruction.

1. Create a page setup in the Harlequin RIP with the following options:

• Device—select the correct device

• Calibration—select the paper/resolution type

2. In the Harlequin RIP, click Output > Print Calibration to open the Print
Calibration window. From the list shown, choose your page setup then
click Print uncalibrated target.

3. Measure the printed target with Genlin, or your preferred calibration
tool. Genlin is installed with the Harlequin RIP and is described in the
Harlequin RIP OEM Manual.

4. In the Harlequin RIP, click Output > Calibration Manager to open the
Calibration (Dot Gain) Manager. In the Manager, click Device and select
the correct device, and then click New to open the Edit uncalibrated
target for… window.

5. In the Edit uncalibrated target for… window click Profile and select the
correct paper/resolution type. All other options should be left at their
default settings (ensure Force solid colors remains unchecked).
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6. In the Name field enter a name for the profile, for example Ucm Enhanced

Matte 720 and click Import > Import to read the calibration data, and
then click OK until all open windows are closed.

7. Modify your page setup so that it uses the named calibration set.

1.10.1.3 Recalibrating the printer

You should periodically recalibrate the printer to ensure consistent output
results, as follows:

1. Click Output > Print Calibration to open the Print Calibration window.
Select the appropriate page setup and click Print calibrated target.
Measure the printed target.

2. In the RIP, click Output > Calibration Manager to open the Calibration (Dot
Gain) Manager window and select the calibration set used in the page
setup.

3. Click Edit from calibrated target to open the Edit calibrated target for…
window. Click Import > Import to read the calibration data and OK to save
the profile. You may want to enter a new name for the profile to indicate
it is an updated profile, for example Ucm Enhanced Matte 720-Date.

4. Modify your page setup so that it uses the new calibration set.

1.11 Creating and installing ICC profiles
The creation and installation of an ICC profile involves these processes:

• Creating a suitable page setup

• Printing and measuring ICC profiling target to produce an ICC profile

• Installing the ICC profile in the RIP

When creating a page setup to use for printing profiling targets you have two
main options:

Raw State You can create a page setup that contains no color man-
agement data:
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Pre Eclipse Release RIPs
In this case both the Color and Calibration menu options
in the page setup must be set to (None).

Eclipse Release or later RIPs
In this case both the ProofReady and Calibration menu
options in the page setup must be set to (None), and
you must choose (No color management) from the
Color menu.

Note: The printer in this ‘raw state’ may not be a suitable basis for creat-
ing profiles.

Golden State You can use a temporary calibration profile or calibra-
tion set in your page setup that supplies a reference
state for the printer.

The option that you choose affects the ICC profile and how you import it.

Note to OEMs: The SetGold utility can be used to create a suitable ref-
erence state calibration profile. See the SetGold User
Guide for details. Alternatively, you can manually create
a linearization profile by referring to the manual
Harlequin Profiles and Calibration.

Having created a suitable page setup, use it to print the ICC profiling target
and measure it using an appropriate software package.

The exact procedure you should use varies from package to package, but it is
possible to give some general hints:

• Total area coverage: For some paper types the total area coverage
should be limited. This depends on the paper, ink type, resolution and
screening used, but a good guide is to limit the coverage to 320% for
uncoated papers and to 400% for coated papers. Some experimentation
may be required to determine the optimum setting.

• Black generation: Because the printer does not have a light black ink
(does not apply to 4000, 7600 and 9600 models), any black ink that is
imaged in highlight regions is visible and can introduce an unnecessar-
ily grainy appearance to some images. Select a setting which images
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black only in dark regions. (If it is not clear which settings will image
black only in dark regions, select the minimum amount of black genera-
tion allowed by the ICC profiling package.)

• Number of patches: Although the number of color patches printed and
measured is not always a guide to color quality, it is generally true that
printing more patches produces better results for any given ICC profil-
ing package.

Having created the ICC profile, install it using the menu option Color > Install
ICC Profile. In the Linear Calibration From menu in the Install ICC Profile dialog
box choose either:

• Linear if the page setup you used contained no color management data
(raw state); or

• The name of the calibration profile or calibration set that you used in
the page setup (golden state). The calibration data is incorporated into
the ICC profile when you import it. This means you can delete the tem-
porary calibration profile or calibration set once you have imported the
ICC profile.

You can create a color setup using this profile (see “Creating a HIPP or Color-
Pro color setup” on page 60 for details).

1.12 Creating a HIPP or ColorPro color setup
The selection of a calibration profile (pre Eclipse Release RIPs) or a
ProofReady profile (Eclipse Release or later RIPs) automatically includes a
default color setup to provide instant color management. The color profiles
used in the default color setups are also available for the creation of your own
color setups. Alternatively, you could also create a color setup using imported
ICC profiles. See “Creating and installing ICC profiles” above for further
information. Creating your own color setup allows you to specify the input
profiles as well as other color setup options.

Follow these steps to create a color setup:

1. Choose the menu option Color > Color Setup Manager.

2. Choose the device for which you want to create this color setup from the
Device menu.
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For example, choose SP10600 VSD Roll.

3. Click New or New ‘ColorPro’ Setup, depending on your RIP version.

4. If using a pre Eclipse Release RIP, click Create in the ICC (HIPP) section
of the Create Color Setup dialog box.

5. In the New Color Setup dialog box, choose the options for the color
setup you are creating.

For example, choose 3M Matchprint for the CMYK input profile and
sRGB for the RGB input profile and then choose Ucm Enhanced Matte

720 as the output profile.

6. Choose (->Default) from the ICC Rendering Intents or Main intent menu,
depending on your RIP version.

7. Set the remaining options as desired. For details of these options see the
Harlequin Color Production Solutions User’s Guide or the Harlequin
ColorPro™ User’s Guide.

8. Click Save As to save this color setup.

9. Enter a name for the color setup in the Save As text box in the Save Setup
dialog box. Click Save and then OK to close the Color Setup Manager.

You may now use this color setup in a page setup.

1.13 Using Harlequin Full Color System (HFCS)
In versions of the RIP prior to the Eclipse Release, the Harlequin Full Color
System (HFCS) can be used to create a color setup, as described in the
Harlequin Color Production Solutions User’s Guide.

Take care to select an appropriate profile for the paper being used and ensure
that the resolution and screening settings are as required by the profile.

When using HFCS there is no need to install ICC profiles for the printer
because HFCS will automatically produce color rendering dictionaries from
the data contained in the selected profile. Should you wish to do so, however,
it is possible to install and use ICC profiles with HFCS in the same way as
with HIPP.
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1.14 Troubleshooting and tips
This section describes messages that may appear in the RIP monitor window
and offers troubleshooting advice and tips on how to maximize your use of
the plugin. If you have difficulty understanding any message, report the exact
message to your support organization.

Note: Most of these messages appear in the RIP monitor window and are pre-
ceded by details of the plugin and device that you are using. For example:

ProofReady - Epson VSD (SP10600 VSD Sheet)
Message...

1.14.1 Printer-specific messages and symptoms

You can clear most output problems by aborting the output from the RIP
and then clearing the media from the printer. Here are some messages
and other symptoms that require different cures:

Auto sheet feeder will not be used because it is not allowed with

the selected media

This message indicates that manual sheet feed has been forced on media
that does not support it. These include: Smooth Fine Art Paper, Textured
Fine Art Paper, Velvet Fine Art Paper.

Auto cut has been switched off because it is not allowed with the
selected media

This message indicates that auto-cut has been prohibited on the selected
roll media type.

Printer rear cover open

Output will stop until the printer cover is closed.

Multi-sensor error

See printer documentation.

Cleaning failed

See printer documentation.
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Ink levels MK n%, C n%, M n%, Y n%, PK n%, LCn%%, LM n%, LK n%

Where n% represents a number followed by a percent sign, for example,
87%. Indicates the remaining percentage of ink for each of the cartridges
on an 8-color printer loaded with 8-color inks.

Ink levels K n%, C n%, M n%, Y n%, K2 m%, C2 n%, M2 n%, Y2 n%

Remaining percentage of ink for each of the cartridges on an 8-color
printer loaded with dual-CMYK inks.

Ink levels K %N, C %N, M %N, Y %N, LC %N, LM %N , LK %N

This message is a warning rather than an error message. It appears peri-
odically and reports as a percentage the amount of ink available in the
printer. To prevent the ‘Ink out’ error message you should monitor these
ink levels.

Warning - ink low - cartridge %s

Where %s is a string, for example, #3, or #2, #5, #7. This message indi-
cates that one or more ink cartridges are getting low – the numbers refer
to the cartridge positions, from left to right, on the printer. (The num-
bers should also be printed above the ink cartridge position on the
printer). #3 means cartridge number 3 is low. #2, #5, #7 means car-
tridge number 2, cartridge number 5 and cartridge number 7 are all low.

The selected ink combination does not match this printer

This issue occurs, for example, when an attempt is made to send Matte
black to a printer which only has Photo black (and is unable to auto-
switch), or when attempting to send a 7-color job to a dual-CMYK
printer.

Note: The plugin is only able to output this message when it is able to
query the printer and check the ink variant. On unidirectional communi-
cation connections, or if the printer is in a state which prevents it
responding to the query, the plugin may be unable to detect the mis-
match before it starts to send the job. In such cases, a command-error
will occur on the printer.
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Control panel in use

This message occurs when the printer control panel is being used. The
plugin resumes printing when the printer allows it, that is, when the
control panel is not being used.

Paper gap error

The paper is too thick or the adjustment lever is in the wrong position.

Cutter position error

The roll paper cutter did not return to the correct position.

Cutter jam

The cutter is jammed.

Ink color error

This error occurs when the ink is changed during a print, for example,
the black ink was changed from Photo to Matte.

Ink combination error

An ink combination error.

This is a PRE RELEASE of the Epson VSD Plugin using Biplane screens

This message appears each time that you use a biplane device type to
remind you that the biplane screens are pre-release screens, and there-
fore are subject to change.

Warning: Top and Bottom Margin values will be swapped.

This warning informs you that your version of the RIP needs to swap
values specified in the Page Layout dialog box for the top and bottom
margins to correctly deal with sheet-fed devices. The warning ensures
that you are aware of this issue, as described on page 51.

Device overrides applied for profile (profile details)

The device settings required by supplied profiles are known to the
plugin and these settings override any settings you may have changed.
This is to ensure correct color management.

For example, if you change the Ink type from UltraChrome to Dye, and
use a supplied profile for an UltraChrome device, the Ink type will be
changed back to UltraChrome by the plugin. To check which settings are
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used when outputting a job, you can open the Configure Device dialog
box from within the Output Controller.

SWOP proofing overrides applied for profile 'SWOP-cert SemiMatte
Proof'

The device settings required by the SWOP certified profile are known to
the plugin and these settings override any settings you may have
changed. This is to ensure correct color management.

Warning - no image in the printable region

This warning is rare and only appears when an image smaller than the
unprintable area is positioned at the edge of the media so that it is com-
pletely clipped. In this case, the job is processed but the output page will
be blank.

Resolution changed to N x N

This message confirms that the square resolution setting in the Page
Setup dialog box has been changed to a N x N mixed resolution. The
reason why you cannot select mixed resolutions in the Page Setup dialog
in some RIPs is explained on page 50.

Page Layout media size is less than the Configure Device paper size
- clipping may occur.

This message can appear if you create a page setup that uses a custom
paper size and you edit the page setup so that it uses a larger, standard
paper size. If this is the case, clipping may occur because the media
values in the Page Layout dialog used for the custom paper size are still
associated with this page setup and in this instance they specify the
maximum paper size. You can either change the media values in the
Page Layout dialog box so that they are larger than the paper size chosen
in the Configure Device dialog box, or you can create a completely new
page setup.

Image width too large for device - clipping may occur
Image height too large for devices

These messages can occur when limits on the movement of the head pre-
vent the printer from using the entire printable area of the media.
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Failed to allocate buffers for swathes (N Kb)

If this message occurs, try increasing both the Minimum memory left for
system and the Memory for the RIP by the amount shown in the brackets.
On a PC platform, both of these options are in the Configure RIP
Options dialog box, accessed by choosing Harlequin RIP > Configure RIP
and clicking Options.

On a Macintosh platform, you must use the menu option File > Get Info
to configure the memory for the RIP. You can then set the preferred size
to your chosen value.

Failed to allocate buffer for compression swathe
Failed to allocate SwatheArray
Failed to allocate BandsCache; not enough memory

If any of these messages occurs, try increasing the Minimum memory left
for system and the Memory for the RIP by multiples of 1 MB. On a PC
platform, both of these options are in the Configure RIP Options dialog
box, accessed by choosing Harlequin RIP > Configure RIP and clicking
Options.

On a Macintosh platform, you must use the menu option File > Get Info
to configure the memory for the RIP. You can then set the preferred size
to your chosen value.

Failed to allocate band buffers (N Kb); not enough memory

If this message occurs, try increasing both the Minimum memory left for
system and the Memory for the RIP by the amount shown in the brackets.
On a PC platform, both of these options are in the Configure RIP
Options dialog box, accessed by choosing Harlequin RIP > Configure RIP
and clicking Options.

On a Macintosh platform, you must use the menu option File > Get Info
to configure the memory for the RIP. You can then set the preferred size
to your chosen value.

Alternatively, you can increase the Printer buffer by the amount shown in
the brackets. This option is also within the Configure RIP Options dialog
box.
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Print buffer is too small to output this page

This message can appear during output. To prevent this error, use File >
Configure RIP to display the Configure RIP dialog box. Set the number
shown for Printer buffer to 32768 KB or more.

Note: You may also see a similar message while using Roam or Reduced
Roam. The cure is the same.

Not enough system memory to output this page

This message can appear during output when the RIP is not supplying
enough memory for the needs of the operating system on the computer.
Set Minimum memory left for system to 10000 Kb in the Configure RIP
Options dialog box. You may need to set a higher figure for large page
sizes.

On Macintosh computers, depending upon when the memory shortage
is detected you may also see the operating system display a warning
dialog box or the computer may hang before being able to display a
message.

Warning - this printer (printer name) may not be the expected model

The model name returned by the printer is not one of the expected
names for the output device. In this case, the quality of the output
cannot be guaranteed.

Unable to confirm printer status/model

Either the connection method does not support bidirectional
communications, or the initial attempt to determine the printer status
and model name did not produce a reply within 15 seconds. The plugin
will assume that the printer is in the correct state and is the correct
model and it will send the job to the printer.

Warning - printer status is unreliable

This messages indicates that the status information being returned by
the printer may be corrupted.

Command error on printer or wrong ink type

If this message occurs, you will need to restart the printer. You should
also check that the ink type selected in your page setup is correct for the
printer, before resubmitting the job.
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The selected ink type is incorrect for this printer

This message can occur when the job or associated profiles are for a dif-
ferent ink type to that installed in the printer. You should ensure that the
Calibration and Color profiles used in your page setup are for the ink
type installed in your printer (Photographic Dye™ versus Archival™), or
that you are using the correct UltraChrome Black (Photo Black versus
Matte Black). You should also check that the Ink type chosen in the
Configure Device dialog is correct, as described on page 33.

%%[Error - Inking regime <name> is not a dictionary ]%%

Each inking regime name should be associated with a value comprising
a PostScript language dictionary.

%%[Error - Inking regime <name> has not been defined ]%%

This message appears when the inking regime information necessary for
the particular ink, screening, inking regime and resolution combination
is missing. Check that you are using a supported combination.

Warning - ink type not recognized and will not be verified

This message appears when the ink type information associated with a
job has not been recognized. In such cases, the plugin cannot verify
whether the printer is using the ink type required by the job.

Printer communication failed ( error details )
Unable to connect to printer ( error details )

The text and numbers in parentheses varies, depending on the reason
why the RIP cannot connect to the printer. The final number is the error
code generated by the operating system and can be used by GGS to
determine the exact cause of the connection failure.

Unknown output method selected
Cannot open selected output method ( error details )
Open error (error details)
Unable to open output (error details)

These messages may appear with a variety of text replacing error

details. The text varies according to the method of output that you
chose in the Epson Configuration dialog box and the exact problem. This
text should help you diagnose the problem. If you have difficulty under-
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standing any message, report the exact message to your support
organization.

Note: The above message may appear if both the parallel port and the
USB port are connected to the printer at the same time. In this case, the
parallel port is disabled by the USB port. To enable the use of the parallel
port, unplug the USB connection at the printer. The printer will immedi-
ately process any page buffers.

Warning - printer maintenance required (see printer panel)
Warning - printer ink cover open
Warning - printer bin 1 paper low
Warning - printer bin 2 paper low
Warning - <ink name> ink low
Warning - <ink name> ink out
Paper jam
Ink out
Paper size /type check error
Paper eject error
Print head too hot
Paper too thick
Printer nozzle check error
Wrong ink cartridge
Printer busy printing through another interface
Printer cover open
Printer paper lever released
Paper out
Wrong paper type or paper type select not complete
Printer initializing
Paper not cut
Printer paper set lever released
Printer ink cover open
Printer ink lever released
Printer is waiting for the ink to dry
Paper not straight

These messages are relayed directly from the printer and should also
appear in the control panel of your printer. See the manual for your
printer for details on how to respond to these error or status messages.

Unknown error (N) reported by printer

This message appears if the RIP is unable to recognize the error reported
by the printer. A brief error message may appear in the Output
Controller/Monitor dialog box, which may help you diagnose the
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problem. If necessary, report the error to your supplier for further
details.

Unable to create file - "full path name of output file"

This message informs you that the RIP was unable to create an output
file. The full path name of the file that it tried to create is specified within
the quotation marks. Check that the file does not already exist and that
the output folder is not read-only. You must also ensure that enough
disk space is available.

Unable to create file using path "full path name of output file"
and template "file name template"

This message informs you that the RIP was unable to create an output
file due to a problem with the file path of the output file and the file
name template. Check that all the specified directories in the full path
name exist and are writeable. If an earlier error message indicates that an
invalid file name template was specified, you must enter a valid file
name template in the Configure Device dialog box.

Job output for "job name", sent on <date> <time>

This message informs you that the RIP has finished sending the job to
the printer. The job name is specified in quotation marks and is followed
by the date and time at which the job was output.

Job output for "job name", filename "full path name of output
file", finished on <date> <time>

This message informs you that the RIP has finished creating an output
file. The job name and the full path name of the output file are specified
in quotation marks, followed by the date and time at which the output
file was closed.

Job output for "job name" is aborting - Printer will print data
that it has already received.

This message can appear during printer output. It is not a separate error,
only an indication of how the RIP and the printer are recovering from an
error reported in an earlier message.

If the RIP aborted due to a problem with the parallel (LPT1) connection
method, you may be prompted to retry or cancel the job. If this is the
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case, click Cancel to abort the job and then check that the printer is
switched on and connected using the correct cable.

Job output for "job name" is aborting

This message can appear during the creation of an output file. It is not a
separate error, only an indication of how the RIP is recovering from an
error reported in an earlier message.

Job output for "job name", aborted on <date> <time>

This message informs you that the RIP has aborted output of the job to
the printer. The reason for aborting the job should be reported in an ear-
lier error message.

Job output for "job name", filename "full path name of output
file", aborted on <date> <time>

This message informs you that the RIP has aborted the creation of an
output file. The reason for aborting the job should be reported in an ear-
lier error message.

Job output for "job name" using path "full path name of output
file" and template "file name template", aborted on <date> <time>

This message informs you that the RIP has aborted the creation of an
output file. The reason for aborting the job should be reported in an ear-
lier error message.

Printer maintenance tank full

Each time you perform nozzle cleaning cycles after changing ink sets on
the Epson Stylus Pro 4000/7600/9600, the excess ink is captured in the
printer maintenance tank. This error message appears when the printer
maintenance tank is full. In this case the current job is aborted. You
should either empty the printer maintenance tank or replace it.

Printer maintenance tank removed

This warning appears when the printer maintenance tank used for col-
lecting excess ink on the Epson Stylus Pro 4000/7600/9600 has been
removed. In this case the current job is suspended until the printer main-
tenance tank is replaced.
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Maintenance tank remaining nn%

The new Stylus Pro 4000/7600/9600 and Stylus Pro 4000 printers have a
maintenance tank for collecting waste ink. When the tank is 50% full, a
warning message is issued. On all Epson VSD printers, if the tank
becomes too full the printer may stop printing altogether.

Printer ejects paper before completing a page

This behavior is normal after the RIP has detected an error and dis-
played a warning message.

Otherwise, this behavior is rare but may occur when using a Microsoft
Windows platform and a parallel port to drive the printer. It may be due
to the mode set for the parallel port, the printer cable, or some interac-
tion between these items. Reset the printer before retrying the same
page. If the problem persists, check the mode set for the port in the com-
puter’s BIOS: do not use EPP mode, particularly if you have a RIP secu-
rity dongle attached to the same port. If the port is also in use for a
dongle, move the printer to another parallel port. Finally, try a new bidi-
rectional parallel printer cable.

Poor or erratic image quality

Try to localize the problem. If there are any error or warning messages
look at their causes and try the associated cures. If there are no messages,
start by printing any test pages available on the printer itself, perhaps
from a test or diagnostic menu. If the problem is not present in any of
these tests, there is likely to be some problem or inappropriate setting in
the page setup.

No output

Make sure that you are sending output to a printer that is properly
connected, powered up, supplied with ink and media, and ready to
receive data. Confirm that the printer itself is working by printing a test
page, alignment test, or similar printer-based function.

Output appears clipped

When printing using large paper sizes or high resolutions a VM Error
may occur. Some jobs may suppress the VM Error and print using the
default page size specified in the Page Layout dialog box, so that the
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output appears clipped. If this occurs we recommend that you increase
the Band size in the Configure RIP options dialog box to 1024 KB.

PhotoInk color management fails to preserve 100% process black

When using a PhotoInk device type, the Preserve 100% process black
color setup option may not be honored. To prevent black from being
color managed in this instance, you should add a page feature to your
page setup, which runs the following PostScript:

<</ReuseColorChains false>> setsystemparams

If necessary, refer to the OEM manual for details on creating and using
page features.

1.14.2 Messages for file name templates

This section details possible error messages that may appear in the RIP moni-
tor window due to the use of incorrect file name templates (see “Output file
naming” on page 37). Suggestions are given to prevent these errors.

All messages are prefixed with the text: File name generation error:

Filename too long for target platform

This message appears when the combined file name stem and extension
are too long for the target platform. For example, the combined length of
the file name stem and extension must not exceed 255 characters on a
Windows platform or 31 characters on a Macintosh platform. To prevent
this error, use truncated tags, as shown in the example for the <dos> tag
in “Examples of tag usage” on page 40.

File stem too long for target platform

This message appears when the file name stem is too long for the target
platform. To prevent this error, restrict the length of the stem by reduc-
ing the fixed text, or by using truncated tags. The example for the <dos>

tag in “Examples of tag usage” on page 40 demonstrates truncation.

Extension too long for target platform

This message appears when the file name extension is too long for the
target platform. For example, file names in UNIX are not considered to
have a separate file name extension. If using the <dot> tag in conjunction
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with the <unix> tag this error would be generated. To prevent this error
create a template such as <unix><jobname>.epf rather than using the
<dot> tag.

Full pathname too long for target platform

This message appears when the full pathname (combination of the file
path and the file name) is too long for the target platform. For example,
in Windows operating systems the full pathname must not exceed 259
characters. To prevent this error, examine the number of characters in the
Browse folders file path (for example, C:\HQ55\RIP\FILES\) and create a
template in which the combined length of the file path and the file name
do not exceed the limit for the platform.

The folder name/path was not supplied

This message appears when the file path is not specified in the Browse
Folders text box within the Epson Configuration dialog box. To prevent
this error, provide a valid file path.

Unknown tag found in template

This message appears when an unknown tag is found in the template.
This is most likely due to a spelling error.

Template contains an incomplete tag

This message occurs when the opening and closing brackets of a tag are
missing, that is < or > is missing.

Filename Template resulted in a null filename

This message occurs when the template only contain characters that are
not allowed in file name on the relevant platform.

Tag delimiter mismatch in template

This message appears when a tag delimiter, either < or >, is missing from
a tag. Check that all the tags have both delimiters.

An extension is required but not found

This message appears when a file extension is expected but is not speci-
fied in the template. For example, if using the <dot> tag, a file extension
must be given.
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File requested is not writeable

This message appears when trying to write to a file that already exists
and that has read-only access. If you wish to overwrite the file, then you
must change the file permissions to provide write access.

Unique name requested but all names are in use

This message appears when no further unique numbers are available.
For example, if using the template stem<1unique><dot>epf, this error
would occur once the file names stem1.epf through stem9.epf had
been generated, because no further unique numbers are available.

1.14.3 Messages for post processing

This section details possible messages that may appear during post processing
(see “Post processing” on page 45).

Running post processing command "command" in folder "folder name"

This is a progress message, confirming the command that is being run,
and the working directory.

Post processing command failed - Cannot change directory to
"directory path"

This error message appears when there is a problem changing to the
specified directory that prevents the completion of the post processing.
Check that the directory exists and that you have permission to access
the directory.

Post processing command failed - "status value"

This error message appears when the post processing has been
unsuccessful. The "status value" is the error code generated by the
command or shell you are using and can be used by your system admin-
istrator to determine the exact cause of the post processing failure.
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1.14.4 Miscellaneous messages

The following is a general list of error messages or warnings that may appear
in the RIP monitor window:

%%[ Error: rangecheck; OffendingCommand: get ]%%

This message may appear if you try to use a 1-bit device type (see “1-bit
device types” on page 3 for details), without first enabling the HEDS1
screening plugin.

To prevent this error, ensure you enable the HEDS1 plugin, as described
in “Installation procedure” on page 4, before using a 1-bit device type.

%%[ Error: VMerror; OffendingCommand: pagedevice ]%%

When printing using large paper sizes or high resolutions a VM Error
may occur. Some jobs may suppress the VM Error and print using the
default page size specified in the Page Layout dialog box, so that the
output appears clipped. If this occurs we recommend that you increase
the Band size in the Configure RIP options dialog box to 1024 KB.

%%[Error: undefinedfilename; Offending Command: run]%%

This error message appears if you have created a device type using a
name similar to the name of the device type on which it is based. If you
use the same text to name the new device as that used to label the device
type, you must match the use of lowercase and uppercase characters in
the device type label. To prevent this error, open the Device Manager,
select the device and click Edit. In the Device Manager Edit dialog box,
change the name of the device to something completely different.

%%[Warning:Error running file <file name>]%%

This warning appears if you there is a PostScript error in the named file.
In such cases, the job will be processed as if the file does not exist.

%%[Error occurred in profile hook <file name>]%%

This warning appears if there is a PostScript error in the named profile
hook file. The job is aborted when such an error occurs.
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*****WARNING: Insufficient working set may result in paging and

performance may be affected

*****Try logging on as a Power User or reducing the memory

allocated to the RIP

This message may occur when using the RIP running on either Windows
NT with service pack 6 or 6a or Windows 2000. It is due to the way these
operating systems deal with memory requests.

You can ignore the warning message because performance is not
affected in this case. If you wish to remove this error message, two possi-
ble solutions exist. You can revert back to using service pack 5 if you are
working on Windows NT. Alternatively, you can reduce the amount of
memory available to the RIP. This may however affect the performance
of the RIP, depending on the total amount of memory that you have
available.

Wrong data format for device(Depth N vs N, Channels N vs N)

This message can appear if you try to output a page buffer generated for
a 2-bit device type to a biplane device type, or vice versa. The RIP dis-
plays this error and disables output in the Output Controller/Monitor
dialog box.

If you wish to output the page buffer, select it from the Active Queue list
and click Info to change the Output device to either a 2-bit or biplane
device type, depending on the device that the page buffer was originally
created for. Deselect the Disable output check box to enable output.

Alternatively, you can delete the page buffer by selecting it and clicking
Remove.

%% [ Error: ioerror; Offending Command: setscreen ] %%

This message can appear if you try to use HDS screens listed in the Edit
Style dialog box before enabling the use of HDS or HDS light. In this
case, you must enable HDS or HDS light in the Configure RIP Extras
dialog box and then re-submit your job.
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1.14.5 Parallel port performance and reliability

We are aware of several problems with parallel port behavior when working
with built-in parallel ports on PC platforms - where the hardware implemen-
tation and supported modes of operation have changed greatly over the
development history of the PC.

For built-in parallel ports, there are different issues under Windows NT as
opposed to Windows ME, Windows 98 and Windows 2000.

Windows NT

Under Windows NT, the data transfer rate of some parallel ports can be
very poor. In most cases, the data rate achieved by the RIP is now as high
as can be achieved by copying a file to the parallel port, but this rate is
often less than you may expect to achieve. (Windows NT always uses
the parallel port in a basic or compatible mode, regardless of BIOS set-
tings such as those discussed next.)

Windows ME/Windows 98/Windows 2000

Under Windows ME, Windows 98, and Windows 2000, the parallel port
driver can achieve higher data rates, especially when operated in ECP
mode. Using this mode the operating system sometimes crashes or shuts
itself down. You can avoid these problems by reconfiguring the parallel
port in the BIOS to select the most basic configuration. The way to enter
and change the BIOS configuration varies from machine to machine, as
does the terminology used for the parallel port mode.

To avoid crashes, try using options with descriptions such as
“bidirectional”, “compatible”, “unidirectional”, or “output only”. Do
not choose any option where the description includes the words ECP or
EPP.

1.14.6 Problems with passwords

If you have problems enabling a device or option you should confirm with
your supplier the password or password file. They may provide you with a
new password or password file. If this is the case, you may need to provide
the serial number of your RIP. The RIP displays this number in the RIP moni-
tor window when starting up, in the form:
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Serial number: 1234-56

You must also tell your supplier the platform for which you require the pass-
word or password file. The platform is the combination of operating system
and processor type. For example, you might specify Windows NT, and Intel
processor (CPU).

Once you have a valid password or password file, follow the relevant steps:

Password file Copy the password file into the Passwords folder,
which is a subfolder of the SW folder. See the Harlequin
RIP OEM Manual for further details.

Password Use the File > Configure RIP menu option to display the
Configure RIP dialog box. Click the Extras button in the
Configure RIP dialog box to display the Extras dialog
box. Select the entry for the device or option that you
wish to add, and click Add to display the Enable Feature
dialog box. Enter the password given to you by your
supplier, and click OK.

1.14.7 Using Chain screening

You may see patterning if you use Chain screening. To optimize output you
should use specific settings in conjunction with Chain screening. The settings
you should use are described in the procedure below:

1. Open the Separations Manager dialog box, using the menu option Color
>Separations Manager.

2. Click New if you wish to create a Separations style that uses Chain
Screening or select the style which uses Chain Screening that you wish
to Edit.

3. Check that Chain is selected from the Dot shape menu.

4. Ensure that Override angles in job is not selected. Do not adjust the angles
as the RIP will now use an optimum set of angles.

5. Ensure that Override dot shape in job and Override frequency in job are
both selected.
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6. Set the screen frequency to 80 lpi by changing the values in
Edit selected row.

7. Ensure that Use Harlequin Precision Screening is not selected.

8. Set the remaining settings as desired.

To further improve output you should use color management. See “Patterning
when not using color management” below.

1.14.8 Notes on the Epson Stylus Photo 2200

When using the Epson Stylus Pro 2200 printer you should be aware of the fol-
lowing issues:

• The printer is unable to recognize when an incorrect paper format has
been loaded. If a roll-mode job is sent to the printer with sheet paper
loaded, the “Paper” indicator on the printer is turned on, but no paper-
out indication is sent to the host and the plugin is unaware the paper is
incorrect. Conversely, do not attempt to send sheet jobs to the printer
when roll paper is loaded; the printer will attempt to feed the whole roll
when a form-feed instruction is received. This also affects Epson’s
nozzle check routine, therefore do not attempt a nozzle check when roll
paper is loaded.

• The printer is particularly prone to ink contamination if overinking
occurs, for example, the yellow nozzle may become contaminated with
black and cyan inks. You should therefore avoid situations where
overinking may occur, particularly at high resolutions or when making
high resolution profiles.

• The printer is unable to indicate to the host which sort of black ink is
loaded. The plugin therefore cannot protect against a Matte Black pro-
file being used with Photo Black, or vice-versa.
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1.14.9 Notes on the Epson Stylus 4000

When using the Epson Stylus Pro 4000 printer you should be aware of the fol-
lowing issues:

• Special attention should be given to the following issue: Do not over-
ride the Feed Sheet Paper message that appears on the printer when a
sheet-mode job is sent to a printer loaded with a roll.

If the operator just presses the Sheet<->Roll switching button the printer
will print the job and then feed the whole roll. The only way to prevent
this is to power off the printer: a simple reset will still dump the roll.

• This release of the plugin (1.2r1) does not support dual CMYK mode.

• The printer does not honour blank skip eject mode on a roll job if Cut
paper after each page is not selected in the Configure Device dialog box.
If a job is aborted (by dragging it out of the active queue for example),
when you subsequently manually invoke a cut from the printer control
panel the full size of paper is ejected, not just the part that was printed
on.

• Extra sheet feed when using software microweave. This may be a
printer firmware issue. Epson are aware of this problem.

• No bi-directional communication when using an Ethernet connection.
The printer is unable to communicate ink levels, paper status and so on
to the plugin when the printer is connected via Ethernet. This is under
investigation with Epson.

• Swathe missing. Occasionally, when using software microweave, a
swathe at the foot of the job fails to print. The result is a print that has
an area approximately 15mm up from the bottom which has not printed
correctly. The last swathe has not printed and therefore the area looks
light (c.75%) of that of the rest of the print.

• Global Graphics do not recommend connecting Ethernet and USB to the
printer, as the following issue has been observed: when the printer is
powered on the operating system detects new hardware via the USB
port and locks all communication with the Ethernet card. Any jobs sent
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to the device via Ethernet will therefore time out and report a communi-
cations failure similar to the following: Printer communication failed

(Send error : 305, 10054).

This behavior has occasionally been observed when only connected via
Ethernet (the network card lights are solidly on, that is, no activity is
evident). Powering the printer off for ten seconds and back on again
may be used to recover from this condition.

1.14.10 Patterning when not using color management

You may see patterning in flat tint areas of black if you print without using
any color management. To avoid this problem, use the supplied calibration
profiles and color profiles, as listed in “ProofReady profiles” on page 19. If the
media or screening type that you wish to use is not supported by the supplied
profiles, then you need to create your own profile. If necessary, you can use
the supplied profiles that are optimized for HDS Super Fine screening with all
of the HDS screen sets.

1.14.11 Sending files to a printer using Windows printer drivers

You can send output to a printer using a networked PC acting as a print
server, by creating an output file in the RIP and then sending this file to a PC
print server. This method allows the use of Windows print spooling and trans-
fers all control of the printer to the print server.

For the RIP running on a PC, you can enter the name of the print server and
printer in the Epson Configuration dialog box when sending output to file.

For the RIP running on a Macintosh computer, you can send files by copying
the file to a PC and then dragging it to the printer.

Note: You cannot send output files to a printer directly connected to a
Macintosh computer. This is because Macintosh computers do not send
printer files directly to a printer. Instead, Macintosh computers use an applica-
tion associated with each file type.
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1.14.11.1 Installing the Windows shared printer

You or your system administrator must install the appropriate Windows
printer on the print server. For example, on Windows NT use Start > Settings >
Printers and open the Add Printer icon. For details, see the description of the
NT Print input method in the Harlequin RIP OEM Manual.

The important points are:

• Choose the correct printer manufacturer and model. If the printer
model is not listed, you may need to click Have Disk and provide a disk
or CD-ROM supplied by the printer manufacturer.

• Make the printer shared and choose an appropriate Share Name.

• Make a note of the share name of the printer for use in the following
RIP procedure.

1.14.11.2 Using the shared printer from the RIP

Once you have produced a shared printer:

1. In the RIP, edit the page setup you wish to use and open the Epson
Configuration dialog box.

2. Choose File from the Output method menu.

3. Enter the name of the PC acting as the print server in the File Output:
Change text box. For example, \\PCPrintserver.

4. Enter the share name of the printer in the File Output: Browse files text
box. For example, Stylus10000.

5. Set remaining options in the Epson Configuration dialog box and Page
Setup dialog box as required and print a file using this page setup.

The RIP does not report the progress of the job; the print server provides this
information.

1.14.12 Calculating memory requirements for the Epson VSD plugin

For correct and reliable operation when using the Epson VSD plugin in the
RIP, you may need to allocate additional memory to the RIP’s basic memory
requirements, which are listed in “System requirements” on page 4.
ProofReady Plugin for Epson Variable Size Droplet Printers 83



1 ProofReady Plugin for Epson Variable Size Droplet Printers

84
The amount of memory required depends on the printer model, the screening
method, job width and output quality you are using. However, using the
information in Table 1.5 and Table 1.6 a reliable figure can be calculated and
added to the Printer buffer and Minimum memory left for system RIP options,
shown in Figure 1.9.

Figure 1.9 Memory allocation settings

The procedure for calculating the memory allocation for the RIP is as follows:

1. Depending on which screening method you are using, refer to Table 1.5
for HEDS1/HDS screening or Table 1.6 for HEDS2 screening. For infor-
mation on which screens are used with the ProofReady profiles see,
“ProofReady profiles” on page 19.
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2. In the appropriate table, look up your printer and the desired output
resolution, and reference the value in the Print Quality column. For
example, on the Stylus Pro 5500 using HEDS2 screening at 1440 dpi with
Fast Microweave quality, the values are 3.3/1.0, as shown below.

In this example, 3.3 refers to the Printer buffer setting and 1.0 refers to
the setting for Minimum memory left for system, which are entered in the
Configure RIP and Configure RIP Extras dialog boxes respectively.

3. To calculate the additional memory settings, multiply the values given
in the table by the width of your job (in inches) and then add 5 to the
printer buffer value for tolerance. For example, assuming your job is 24
inches:

Printer buffer: (24 x 3.3) + 5 = 84.2 (84200 Kb)

Minimum memory left for system: 24 x 1.0 = 24.0 (24000 Kb)

It is advisable to calculate the widest job you are likely to require and
then use those settings to avoid having to constantly update the memory
allocation.

4. Add these values to the base figures required for the RIP, which are as
follows:

Printer buffer: 20000 Kb (Windows/UNIX/Mac OS X)

30000 Kb (Mac OS 9.x)

Minimum memory left for system
30000 Kb
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For example, using the values given in the table above the new settings
in Windows XP would be:

Printer buffer: 104200 Kb (Windows/UNIX/Mac OS X)

114200 Kb (Mac OS 9.x)

Minimum memory left for system
54000 Kb.

5. Click OK twice to close the dialog boxes. You will be prompted to restart
your RIP. When you restart, you will now have enough memory allo-
cated in the appropriate places to run your job.

Key:

N/A Indicates that the Printer Microweave option is not
available at that particular resolution.

Table 1.5 Memory requirements for HEDS1 and HDS

HEDS1/HDS Print Quality

Resolution
Enhanced

Microweave
Standard

Microweave
Fast Microweave

Printer
Microweave

Epson Stylus Pro 4000

360 dpi 0.2/0.3 0.2/0.2 0/0 0/0*

2880 dpi 3.6/3.7 3.6/3.7 3.6/3.7 0/0*

Epson Stylus Pro 5500

360 dpi 0.2/0.2 0.2/0.2 0.2/0.2 0/0*

2880 dpi 1.0/1.0 1.0/1.0 1.0/1.0 N/A

Epson Stylus Pro 7600/9600

360 dpi 0.1/0.1 0.1/0.1 0.1/0.1 0/0*

2880 dpi 1.9/2.0 1.9/2.0 1.9/2.0 0/0*
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* There are no additional requirements when using the
Printer Microweave option, as indicated by the 0/0

entries.

The following table lists the HEDS2 requirements:

Table 1.6 Memory requirements for HEDS2

HEDS2 Print Quality

Resolution
Enhanced

Microweave
Standard

Microweave
Fast Microweave

Printer
Microweave

Epson Stylus Pro 2200

360 dpi 0.5/0.3 0.5/0.2 0/0 N/A

720 dpi 1.9/1.1 3.8/1.1 3.8/1.1 N/A

1440 dpi 3.8/1.1 3.8/1.1 3.8/1.1 N/A

2880 dpi 15.2/3.9 15.2/3.9 15.2/3.9 N/A

Epson Stylus Pro 4000

360 dpi 0.9/0.6 0.9/0.4 0/0* 0/0*

720 dpi 3.6/1.9 3.6/1.0 3.6/1.0 0/0*

1440 dpi 7.1/1.9 7.1/1.9 7.1/1.9 0/0*

Epson Stylus Pro 5500

720 dpi 1.7/0.5 1.7/0.5 1.7/0.5 N/A

1440 dpi 3.3/1.0 3.3/1.0 3.3/1.0 0/0*

2880 dpi 6.6/1.9 6.6/1.9 6.6/1.9 N/A

Epson Stylus Pro 7600/9600

360 dpi 0.5/0.4 0.5/0.2 0.5/0.2 0/0*

720 dpi 2.0/1.1 2.0/0.6 2.0/0.6 0/0*

1440 dpi 3.9/1.1 3.9/1.1 3.9/1.1 0/0*

Epson Stylus Pro 10000/10600

360 dpi 0.8/0.6 0.8/0.3 0.8/0.3 0/0*
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1.15 Related documentation
For more details about the printer you are using, see the manufacturer’s docu-
mentation supplied with the printer or the relevant product support section of
the manufacturer’s web site.

For more information about the RIP, see the Harlequin RIP OEM Manual.

For more information about HCPS, see the Harlequin Color Production Solutions
User’s Guide.

For more information about Harlequin ColorPro, see the Harlequin ColorPro™

User’s Guide.

720 dpi 3.1/1.7 3.1/1.7 3.1/1.7 0/0*

1440 dpi 6.1/1.7 6.1/1.7 6.1/1.7 0/0*

Table 1.6 Memory requirements for HEDS2

HEDS2 Print Quality

Resolution
Enhanced

Microweave
Standard

Microweave
Fast Microweave

Printer
Microweave
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